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DER NETZWERK-HYPE

Kaum ein Begriff ist derzeit so en vogue wie der des „Netzwerks“.1 In der Sprache 
von Business-, Politik- und Wissenschaftswelt bezeichnet „Netzwerken“ („networ-
king“) immer häufiger eine strategische Handlungspraxis, die früher argwöhnisch 
als „Strippenziehen“ oder unschickliche „Kungelei“ beäugt wurde; heute jedoch gilt 
das „Gut-vernetzt-sein“ als maßgeblich für den beruflichen Erfolg. Und in Zeiten 
des Web 2.0 ist das „www“ nicht mehr nur Internet, sondern dank (?) facebook & 
Co explizit auch ein Socialnet und mit Smartphones für viele Menschen zudem fast 
allgegenwärtig. Aber nicht nur im kleinen Zwischenmenschlichen, auch im großen 
„Globalen“ ist der Netzwerkbegriff omnipräsent: Er ist zur zentralen Perspektive 
gesellschaftlicher Selbstbeobachtung geworden und ist die Universalmetapher 
großer Gesellschaftsdiagnosen unserer Zeit. „Globalisierung“, „Konnektivität“, 
„Vernetzung“ oder die berühmten „kleinen Welten“ und das „Global Village“ sind 
Schlagworte unserer „Netzwerkgesellschaft“ (Castells 2001). 

Es ist festzustellen, dass sich „das Netzwerk“ nicht nur alltagssprachlich zu 
einem modernen Leitbegriff entwickelt hat; auch in den Wissenschaften erfreut 
es sich immer größerer Beliebtheit. Bereits ein kursorischer Blick auf die Ent-
wicklung der Publikationszahlen in den letzten zwei Dekaden verdeutlicht sehr 
eindrücklich: Der Netzwerkbegriff boomt und breitet sich aus (vgl. Abb. 1 und 2).

Abb. 1:	Anzahl der Publikationen mit „Netzwerk“ im Titel pro Jahr (SSCI2, 1990–2011) 

1 Als die Autoren am 29.10.2012 bei Google den Begriff „network“ als Suchbegriff eingaben, erhielten sie 3,4 Mrd. 
hits. Zum Vergleich: Der Begriff „sex“ ergibt weniger, nämlich nur 3,2 Mrd., „truth“ produziert 0,75 Mrd., „freedom“ 
0,72 Mrd., „climate“ nur 0,39 Mrd. und „terror“ erstaunlicherweise lediglich 0,31 Mrd. Treffer. Allerdings fällt die Anzahl 
der gefundenen Seiten für den Suchbegriff „money“ mit 3,5 Mrd. immer noch knapp höher aus als die Vergleichszahl 
von „network“. Immerhin ergibt „love“ fast 8,5 Mrd. hits – ist ja eigentlich auch der viel schönere Leitbegriff! 
2 Gesucht wurde über die SSCI-Datenbank (Social Sciences Citation Index) des Wissenschaftsdienstes Thompson 
Reuters mit dem Suchschlüssel Title und dem trunkierten Suchbegriff „network“.
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Quelle: eigene Darstellung [SSCI, n=24.545 Publikationen]
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Abb. 2:	Anzahl der Publikationen mit „Netzwerk“ im Titel nach Forschungsgebiet3 (SSCI, 1990–2011) 

Während der Netzwerkbegriff auch in der Wissenschaft lange Zeit meist metapho-
risch verwendet wurde, formiert und profiliert sich in den letzten Jahren zuneh-
mend eine disziplinübergreifende Netzwerkforschung, die das Netzwerk explizit 
als ein analytisches Konzept begreift (vgl. Gamper, Reschke 2010). Bei der sozial-
wissenschaftlichen Netzwerkforschung handelt es sich um eine Form der Analyse 
von sozialer Ordnung. Im Zentrum steht der organisationale Aspekt menschli-
cher Interaktion in komplexen Sozialstrukturen, die durch Verschachtelung und 
Überlappung verschiedener Arten sozialer Beziehungen charakterisiert sind. Dabei 
geht es um die Untersuchung von Netzwerkstrukturen unterschiedlicher Form und 
unterschiedlichen Inhalts sowie um die Einbettung von Akteuren in diese Struk-
turen. Das Netzwerkparadigma zielt – sehr allgemein gesprochen – darauf ab, die 
Konsequenzen der Netzwerke für das Handeln der eingebundenen Akteure sowie 
die Folgen des Handelns in Netzwerken für die Netzwerke selbst und darüber 

3 Forschungsgebiete entsprechen hier den von Thompson Reuters aggregierten research areas. Die Einteilung der 
Forschungsgebiete ist nicht trennscharf und deckt sich nur zum Teil mit der vertrauten disziplinären Subdifferenzierung 
der Wissenschaft.
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Quelle: eigene Darstellung [SSCI, n=24.545 Publikationen]
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hinaus herauszuarbeiten (vgl. Schweizer 1989; Holzer 2006; Jansen 2006). Oft 
wird das Netzwerk als eine Art Mesoebene beschrieben, die einen analytischen 
Link zwischen der individuellen Akteursebene und der Ebene gesellschaftlicher 
Makrostrukturen darstellt.

Eng verknüpft mit dieser relationalen Perspektive der sozialwissenschaftlichen 
Netzwerkforschung ist das methodische Programm der Social Network Analysis 
(SNA). Die SNA wird in verschiedenen Disziplinen (z. B. Ethnologie, Soziologie, 
Politik-, Wirtschaftswissenschaften) als empirische Methode der Sozialforschung 
immer häufiger angewendet.4

Angesichts des allgemeinen Netzwerk-Hypes erstaunt es nicht, dass die Netz-
werkperspektive und die SNA auch in der Geographie methodologisch verstärkt 
Fuß fasst bzw. „Raum“ greift (vgl. Abb. 3 und 4).5 

Abb. 3:	 Anzahl der geographischen Publikationen mit „Netzwerk“ im „Titel“ pro Jahr (international) (SSCI6, 1990–2011) 

4 Ursprünglich wurzelt das aufstrebende und inzwischen etablierte Paradigma der sozialen Netzwerkanalyse in der 
britischen Sozialanthropologie der 1960er Jahre und in der amerikanischen Soziologie der späten 1970er und frühen 
1980er Jahre. Eine stärkere Institutionalisierung erfuhr sie vor allem mit der von Barry Wellman initiierten Gründung 
der International Society of Social Network Analysis (INSNA) im Jahr 1978 und den beiden Journals „Connections“ und 
„Social Networks“ sowie der jährlichen „Sunbelt International Conference on Social Network Analysis“.
5 Glückler (2010) weist jedoch zu Recht darauf hin, dass der Begriff des Netzwerks bereits eine lange Tradition 
in der Geographie hat. Fragen der Netzwerkgeometrie räumlicher Infrastrukturen (Lagerelationen, Topologie, 
Konnektivität) standen früh im Blickpunkt geographischer Forschungsarbeit.
6 Gesucht wurde über die SSCI-Datenbank (Social Sciences Citation Index) des Wissenschaftsdienstes Thompson 
Reuters mit dem Suchschlüssel „title“ und dem trunkierten Suchbegriff „network“, eingeschränkt auf research area 
„geography“ (n=1.254). 
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Abb. 4:	Anzahl der geographischen Publikationen mit „Netzwerk“ im Titel pro Jahr (Deutschland) (SSCI7, 1990–2011) 

DIE NETZWERKPERSPEKTIVE IN DER HUMANGEOGRAPHIE

Die wissenschaftliche Disziplin der Humangeographie untersucht – wiederum 
sehr allgemein gesprochen – das Verhältnis zwischen Raum und Gesellschaft 
und fragt nach der räumlichen Organisation sozialer Praktiken, gesellschaftli-
cher Institutionen und wirtschaftlichen Austauschs (Glückler 2010: 881). Lange 
Zeit konzipierte die Geographie das Gesellschaft-Raum-Verhältnis als territorial 
bzw. lokal gebunden. Mittlerweile gilt es jedoch als common sense, dass sich die 
Lebens- und Wirtschaftsweisen im Zuge von Modernisierung und Globalisierung 
sowie der Neuerungen im Bereich der Transport- und Kommunikationstechnologie 
zunehmend „geographisch entankert“ haben: 

„Diese neue Ära, die sich durch neue Formen der Herstellung geographi-
scher Bedingungen und Verhältnisse auszeichnet, beruht vor allem auf dem 
Verschwinden der Bedeutung der Distanz als Handlungshemmnis für zahl-
reiche Lebenszusammenhänge. Damit ist die Eröffnung der Möglichkeit des 
Handelns über Distanz verbunden“ (Werlen 2000: 6).

Das bedeutet, dass die Lebensverhältnisse insgesamt „raumzeitlichen Schrump-
fungsprozessen“ (Harvey 1990) unterworfen sind. 

7 Gesucht wurde über die SSCI-Datenbank (Social Sciences Citation Index) des Wissenschaftsdienstes Thompson 
Reuters mit dem Suchschlüssel Title und dem trunkierten Suchbegriff „network“, eingeschränkt auf research area 
„geography“ und Country „Germany“ (n=106). Zahlreiche Europäische Zeitschriften werden im SSCI noch nicht erfasst. 
Entsprechend liegt die tatsächlich Zahl geographischer Publikationen über den hier angegebenen Werten. (Im SSCI 
nicht erfasst sind u. a.: Berichte z. dt. Landeskunde, Geographica Helvetica oder die Geographische Rundschau.)
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Diese territoriale Entankerung und die potentielle Entkopplung sozialer und 
ökonomischer Interaktion von der Notwendigkeit physischer Anwesenheit stellt 
die Humangeographie vor die Herausforderung, das Verhältnis von Territorium 
und Gesellschaft bzw. „dem Raum“ und „dem Sozialen“ grundlegend zu überden-
ken. Die sozialwissenschaftliche Netzwerkforschung stellt in diesem Kontext ein 
vielversprechendes Angebot bereit. Sie bietet die Möglichkeit, soziale Sachverhalte 
grenz- und territoriumsübergreifend zu denken. 

Das „soziale Netzwerk“ ist dabei zunächst ein sehr unräumliches Konzept ohne 
unmittelbare geographische Bezüge. Um sich also auf allgemeiner Ebene der Frage 
zu nähern, was Netzwerke mit Geographie zu tun haben, bietet es sich zunächst 
an, nach dem Zusammenhang zwischen sozialen Netzwerken und dem zu fragen, 
was gemeinhin als zentraler und vereinender Gegenstand unseres Faches gilt – 
also nach dem Verhältnis von Netzwerk und Raum. 

Zum einen stellt sich hierbei für die Forschung die grundsätzliche Frage nach 
Explanans und Explanandum: Will man also netzwerkbezogene Raumforschung betrei-
ben, indem man irgendetwas „Räumliches“ durch soziale Netzwerke zu erklären 
versucht, oder will man andersherum raumbezogene Netzwerkforschung betreiben, 
indem man beabsichtigt, Netzwerke durch etwas „Räumliches“ zu erklären? 

Zum anderen ist der Nexus auch in Abhängigkeit von der jeweils zugrunde 
gelegten Konzeption dessen, was unter „Raum“ überhaupt zu verstehen ist (vgl. 
Wardenga 2002)8, theoretisch auf mindestens dreierlei Weise zu denken: 

1. Bedeutung des „Raumes“ für Netzwerke und andersherum 

Die klassischen geographischen Fragen einer solchen Forschung wären z. B.: Welche 
Bedeutung hat räumliche Nähe für soziale Netzwerkbildung? Wie beeinflussen Raum-
strukturen die Entstehung und Aufrechterhaltung sozialer Netzwerkstrukturen? Oder 
andersherum: Wie beeinflussen spezifische soziale Netzwerke die Ausformung von 
(physisch-materiellen, ökonomischen etc.) Strukturen (d. h. die „Raumausstattung“) 
in einem bestimmten erdräumlichen Ausschnitt? (→ Containerräumliche Perspektive)

2. Bedeutung von Netzwerken im „Raum“

Im Mittelpunkt der Untersuchung steht hier die Verteilung und Verknüpfung von 
Knotenpunkten (Akteuren) an verschiedenen Raumstellen. Die Netzwerke werden 
dann als quasi-räumliche Strukturen aufgefasst. Die Netzwerklinien (Beziehungen, 
Kanten) werden verstanden als räumliche Verknüpfungs- bzw. Verflechtungszusam-

8 Wardenga (2002: 5) unterscheidet vier geographische Raumkonzeptionen: 1. Raum als „Containerraum“, in dem 
bestimmte Sachverhalte der physisch-materiellen Welt verortet und diese dann als räumliches Wirkungsgefüge natürlicher 
und anthropogener Faktoren verstanden werden, 2. Raum als „Lage-Relationsgefüge“ materieller Objekte (Betonung 
der Bedeutung von Standorten, Lage-Relationen und Distanzen für die Schaffung gesellschaftlicher Wirklichkeit), 
3. Raum als „Wahrnehmungsraum“, d. h. als Kategorie der Sinneswahrnehmung und als Anschauungsformen, mit 
deren Hilfe Handlungen „räumlich“ differenziert werden, 4. Räume als „soziale Konstruktionen“, d. h. als Ergebnis 
kontinuierlicher (alltäglicher) Handlungs- und Kommunikationsprozesse.
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menhänge und die Transaktionen und Flüsse (Waren, Kapital, Informationen etc.) 
entlang dieser Netzwerklinien werden als räumliche Distributions- und Austausch-
prozesse analysiert. (→ Raum als Lage-Relationsgefüge)

3. Bedeutung des „Raumes“ in Netzwerken

Ausgangspunkt hierbei ist ein konstruktivistisches Raumverständnis. Zentral ist 
hier die Bedeutung von raumbezogenen Semantiken für die Bildung und Stabili-
sierung von Netzwerken. Raum fungiert als Medium der Kommunikation und oft 
als In- und Exklusionskategorie in sozialen Netzwerkzusammenhängen, sprich als 
ein kommunikatives Mittel, um soziale Beziehungen herzustellen, zu begründen, 
zu stabilisieren oder auch zu verhindern. Andersherum wäre hier ebenfalls zu 
fragen, wie Räume durch (alltägliche) Praktiken und Kommunikation in spezi-
fischen Netzwerkzusammenhängen sozial hergestellt und reproduziert werden. 
(→ Raumkonstruktivistische Perspektive) 

In der humangeographischen Forschung kann die soziologische Perspektive der 
klassischen Netzwerkforschung also auf unterschiedliche Weise um eine „räum-
liche Dimension“ bzw. einen „Raumbezug“ ergänzt werden. 

International kommen analytische Konzepte der sozialen Netzwerkperspektive 
mittlerweile in verschiedenen geographischen Forschungsfeldern zur Anwendung. 
Zu denken ist hier etwa an die Metropolen- und Regionalforschung, die geographi-
sche Entwicklungsforschung, die Migrations- und Transnationalismusforschung, 
aber auch an die wirtschaftsgeographischen Felder der Standortforschung, der 
Innovationsforschung sowie an die Erforschung von lokalen, regionalen bis glo-
balen Produktionsnetzwerken, Wertschöpfungsketten oder Wissensclustern (vgl. 
auch Glückler 2010). 

Interessanterweise findet diese konzeptionelle Annäherung zwischen Netz-
werkforschung und Geographie derzeit keineswegs nur einseitig statt: Nicht nur 
die Geographie öffnet sich zunehmend in Richtung der Netzwerkperspektive, 
sondern die allgemeine sozialwissenschaftliche Netzwerkforschung wendet sich 
– wohl auch im Anschluss an den spatial turn – derzeit verstärkt räumlichen/geo-
graphischen Fragestellungen zu. Dieses multi- und interdisziplinäre Interesse an 
dem Nexus „Raum/Netzwerk“ bietet durchaus Anknüpfungspunkte („Brücken“) 
für eine wechselseitige Befruchtung und eröffnet zudem eine vielversprechende 
Möglichkeit, geographische Forschung an aktuelle sozialwissenschaftliche Dis-
kussionen anschlussfähig zu machen.9 

9 Vgl. z.  B. Goeke, Zehetmaier (2012), die sich aus systemtheoretischer Perspektive mit (geographischer) 
Netzwerkforschung beschäftigen.
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DIE METHODE DER SNA IN DER HUMANGEOGRAPHIE

Um die Netzwerkperspektive empirisch zu operationalisieren, greifen Humangeo-
graphen in ihrer Forschung in jüngerer Zeit vermehrt auf das Methodenrepertoire 
der formalen Social Network Analysis (SNA) zurück. Auch in der deutschen Human-
geographie wird verstärkt mit dem Methodenset der SNA gearbeitet. Allerdings 
sind es derzeit nur gut ein Dutzend deutsche Geographen, die sich methodisch im 
SNA-Feld tummeln.10 Insbesondere die Sozial- und die Kulturgeographie scheint 
hier (im Vergleich zur Wirtschaftsgeographie) einen deutlichen Nachholbedarf 
zu haben. Das mag daran liegen, dass sich empirisch arbeitende Sozial- und 
Kulturgeographen in jüngerer Zeit hauptsächlich an qualitativen Verfahren der 
Sozialforschung orientieren.

Die formale SNA ist eine quantitative Methode zur Auswertung relationaler 
Daten.11 Sie analysiert gemeinhin sogenannte Gesamtnetzwerke.12 Auf allgemei-
ner Ebene werden diese definiert als eine zuvor abgegrenzte Menge von sozialen 
Akteuren (Knoten) und spezifischen, zwischen ihnen bestehenden Beziehungen 
(Kanten/Relationen) (vgl. Knoke, Kuklinski 1982; Wassermann, Faust 1994).13 
Die SNA basiert auf graphentheoretischen Modellen und zielt auf die Berechnung 
und Visualisierung statistischer Kennzahlen zur Untersuchung von Netzwerken. 
Im Mittelpunkt der Analyse stehen zum einen das Beziehungsgeflecht selbst (die 
Strukturen) und zum anderen die relationalen Merkmale der eingebetteten Akteu-
re mit ihrem sozialen Status innerhalb der Gesamtstruktur (die Positionen) (vgl. 
Wasserman, Faust 1994; Jansen 2006). 

Im Vergleich zu anderen Methoden der quantitativen und qualitativen empirischen 
Sozialforschung sowie der Fernerkundung und GIS-Anwendungen, nimmt die SNA 
in der Methodenausbildung an geographischen Instituten in Deutschland bisher 
einen sehr untergeordneten Stellenwert ein. Erst in den letzten Jahren scheint 
sich das steigende Interesse an Netzwerken und der SNA auch im Lehrangebot 
geographischer Institute in Deutschland niederzuschlagen (z. B. an den Instituten 
Heidelberg [Johannes Glückler], Hannover [Tom Brökel], Osnabrück und Potsdam 
[Malte Steinbrink], und Erlangen [Tim Elrick]). 

Die Lehrveranstaltungen zur Netzwerkanalyse umfassen meist eine theoretische 
Einführung in die Historie und die verschiedenen Entwicklungslinien der sozial-
wissenschaftlichen Netzwerkforschung und vermitteln zudem die grundlegenden 

10 Am Ende dieses Handbuchs findet sich eine Liste exemplarischer geographischer Arbeiten, die sich mithilfe 
der Methode der SNA mit unterschiedlichen Forschungsthemen auseinandersetzen (s. Kap. 3).
11 Neben der quantitativen existiert auch die qualitative Netzwerkanalyse, die vor allem für die Kombination von 
formalen und qualitativen Verfahren plädiert (vgl. u. a. Hollstein, Straus 2006). 
12 Ein zweiter Strang der Netzwerkanalyse beschäftigt sich mit Egonetzwerken. Dabei wird ein „Ego“ zur Bestimmung 
seiner „Alteri“ und der jeweils zu ihnen bestehenden Beziehungen befragt. Eine solche Analyse beruht folglich auf 
Daten, die aus der Perspektive des Egos erhoben werden (vgl. Herz 2012).
13 Diese grundlegende Definition geht auf Mitchell (1969: 2) zurück: „[...] social network as a specific set of linkages 
among a defined set of persons with the additional property that the characteristics of these linkages as a whole 
may be used to interpret the social behavior of the persons involved.“ 



16 Netzwerkanalyse in der Humangeographie –  Einleitung zur Einführung 

Begrifflichkeiten und analytischen Konzepte. Zu diesen Aspekten liegen mittler-
weile zahlreiche Lehrbücher vor, auf die in den Seminaren zurückgegriffen werden 
kann.14 Darüber hinaus zielen die Lehrveranstaltung sinnvollerweise darauf ab, 
die praktischen Anwendung der SNA zu vermitteln und eine Einführung in eine 
Analyse-Software15 zu geben. Anders als für die theoretischen Grundlagen ist das 
Lehrmaterial für diese praktische Einführung aber eher begrenzt – was u. U. auch 
daran liegen mag, dass die Software selbst keineswegs durch Übersichtlichkeit 
und Anwenderfreundlichkeit besticht. Die vorhandenen Handbücher erweisen 
sich bisweilen für Einführungsseminare als zu umfangreich, überkomplex und 
verwirrend – gerade für Anfänger.

Genau an dieser Stelle will das vorliegende kleine Handbuch ansetzen …

ZIELSETZUNG UND AUFBAU DES HANDBUCHS

Mit dem vorliegenden Handbuch verfolgen wir das Interesse, bei der Durchsetzung 
der Netzwerkanalyse in Lehre und Forschung an geographischen Instituten in 
Deutschland ein kleines bisschen behilflich zu sein. Entstanden ist das Heft im 
Kontext von vier Methodenseminaren zur Netzwerkanalyse, welche die Autoren 
zwischen 2009 und 2012 an den Universitäten Osnabrück und Potsdam leiteten. 
Diese Seminare waren nicht nur eine Einführung in theoretische, methodolo-
gische und methodische Grundlagen, sondern gleichzeitig als Lehrforschungen 
konzipiert.16 D. h. die Methoden und Programmanwendungen wurden von den 
Studierenden im Forschungsprozess erlernt und direkt für die Analyse selbster-
hobener Daten genutzt. 

Insbesondere in Bezug auf die praktische Einführung in das Analyseprogramm 
UCINET sind uns durchaus Berührungsängste aufgefallen, die bei einigen Kur-
steilnehmerInnen zu einer gewissen Starthemmnis führten.

14 Am Ende dieses Handbuchs befindet sich für einen Überblick eine Liste mit weiterführenden Lehrbüchern zur 
Netzwerkforschung (s. Kap. 3).
15 Es gibt heute mittlerweile mehr als 50 verschiedene Computerprogramme zur Analyse von Netzwerken. Einen 
Überblick bieten Huismann, van Duijn (2011). Für Gesamtnetzwerke sind vor allem zu nennen: 
Pajek (http://pajek.imfm.si/doku.php?id=pajek): Pajek wird von den slowenischen Mathematikern Vladimir Batagelj 
und Andrej Mrvar entwickelt. Die Stärken des Programms liegen in sehr schnellen und guten Rekodierungsverfahren. 
Allerdings sind nur deskriptive und explorative Verfahren durchführbar. Stochastische Verfahren mit Signifikanzprüfungen 
sind nicht möglich. Mittlerweile liegt ein gutes Lehr- und Übungsbuch zu Pajek vor (De Nooj, Mrvar, Batagelj 2011).
Gephi (https://gephi.org/): Gephi ist ein noch junges Open-Source-Projekt und wird kollektiv regelmäßig weiterentwickelt. 
Als besondere Stärken sind hier die hervorragende Nutzerfreundlichkeit und die guten Visualisierungsmöglichkeiten 
hervorzuheben.
UCINET (https://sites.google.com/site/ucinetsoftware/): UCINET ist wohl die in der Lehre am meisten genutzte SNA-
Software. Die wichtigsten Analyse- und Visualisierungsverfahren können mit UCINET durchgeführt werden und 
werden im Folgenden im Einzelnen näher vorgestellt. 
Neben diesen Programmen zur Analyse von Gesamtnetzwerken gibt es auch spezielle Software zur Erhebung und 
Analyse egozentrierter Netzwerke. Zu nennen sind hier vor allem: Egonet (http://egonet.softpedia.com/), Visone 
(http://visone.info/) und Vennmaker (http://www.vennmaker.com/). 
16 Der innerhalb der deutschen Geographie stark wahrgenommene Beitrag zu humangeographischen Wissensnetzen 
an deutschen Universitäten (Steinbrink et al. 2012) ist ein Ergebnis dieser Lehrforschungen.
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Diese Anleitung will diese Berührungsängste nehmen und den Einstieg erleich-
tern! Er ist keineswegs als Einführung in die SNA oder als Ersatz für das „offizi-
elle“ Programm-Tutorial gemeint. Das kleine Handbuch will also weder zeigen, 
was man mit der Netzwerkanalyse (in der Geographie oder anderswo) so alles 
anstellen kann noch will es Leistungsfähigkeit und Anwendungsvielfalt des Pro-
gramms demonstrieren.17 Vielmehr geht es lediglich um eine Einführung in die 
allergrundlegendsten Funktionen der Analyse-Software UCINET und der Visua-
lisierungssoftware NetDraw. Dieses Handbuch will bei den ersten eigenen Schrit-
ten unterstützend begleiten. Entsprechend gehen wir in fünf – teils aufeinander 
aufbauenden – Schritten vor (Kap. 2):

Zunächst werden in Schritt 1 unterschiedliche Wege zur Eingabe und zum Einlesen 
von Netzwerkdaten vorgestellt. In Schritt 2 werden daraufhin erste Berechnun-
gen einfacher struktureller Merkmale von sozialen Netzwerken erklärt (Dichte, 
Reziprozität, Subgroups). Schritt 3 befasst sich dann mit Verfahren der Netz-
werktransformation (Dichotomisierung, Symmetrisierung und Zusammenfügen 
von Netzwerkdatensätzen). Im Schritt 4 werden die geläufigsten Methoden zur 
Beschreibung von Akteurspositionen in sozialen Netzwerken, d. h. Berechnungen 
unterschiedlicher Zentralitätsmaße (Degree, Closeness, Betweeness), erläutert. 
In Schritt 5 werden schließlich einige ausgewählte Verfahren beschrieben, wie 
Netzwerke unter Berücksichtigung von Attributen analysiert werden können 
(Homophilie, Blockbildung, QAP).

Das Mini-Handbuch ist so gestaltet, dass diese fünf Schritte im Sinne eines Read-
and-Click nachvollzogen werden können. Zur Veranschaulichung und zur Orien-
tierung auf der Programmoberfläche dienen die zahlreichen screen shots (Damit 
man weiß, welche Knöpfchen man drücken muss, bzw. wie die Ausgabe-Datei 
aussehen müsste, wenn man die richtigen Knöppe drückt!). Ergänzend werden 
zentrale Begriffen der SNA in den jeweiligen Abschnitten einführend erläutert 
oder definiert (→ graue Textboxen). Die dort angegebenen Quellen weisen auf 
Lehrbücher und grundlegende Standardtexte der SNA hin. 

Am Ende des Buches (Kap. 3) werden zwei Überblicke über weiterführende Lite-
ratur gegeben: Der erste stellt eine systematische Zusammenstellung der Lehr- und 
Einführungsliteratur zur sozialwissenschaftlichen Netzwerkforschung und -analyse 
in Form eines tabellarischen Überblicks dar. Um konkrete Anwendungsbeispiele 
und die Bandbreite bisheriger geographischer netzwerkanalytischer Forschung 
aufzuzeigen, ist dort ebenfalls ein Überblick über geographische Arbeiten zu finden, 

17 Siehe dazu die Auflistung exemplarischer netzwerkanalytischen Arbeiten in der deutschsprachigen Humangeographie 
in Kap. 3 dieser Einführung. 
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die sich mithilfe der Methode der SNA mit unterschiedlichen Forschungsfeldern 
auseinandersetzen. 

Wir hoffen, dass diese Anleitung für einige Studierende den Einstieg in die prak-
tische Netzwerkforschung erleichtert und Mut macht, die nächsten Schritte in 
die Tiefen des Programms und in komplexere Methoden der SNA eigenständig 
zu gehen. 

Wir freuen uns auf viele interessante Arbeiten zur geographischen Netzwerk-
forschung!

Malte Steinbrink, Jan-Berent Schmidt und Philipp Aufenvenne 
Osnabrück und Klagenfurt, im Frühjahr 2013
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Schritt 1 – Eingabe und Einlesen der Daten

ANLAGE EINER DATENSTRUKTUR

Zu Beginn ist es notwendig, einen Projektordner anzulegen. In diesem Ordner wer-
den alle Programmdateien, die von UCINET erzeugt werden, gespeichert. Diese 
werden für die verschiedenen Funktionen und später für die Darstellung in Net-
Draw benötigt.

Nach der Installation des Programms UCINET18 wird das Programm geöffnet und 
unter File > Change Default Folder der Projektordner ausgewählt (Abb. 5). Im 
Suchfenster kann entweder ein bestehender Ordner ausgewählt oder ein neuer 
Ordner erstellt werden. Es ist empfehlenswert, für jedes Projekt einen neuen 
Ordner anzulegen, da UCINET eine nicht unerhebliche Menge Dateien produziert 

18 Test- und Vollversion unter http://www.analytictech.com/ucinet/ oder https://sites.google.com/site/ucinetsoftware/

Abb. 5:	Projektordner öffnen

Abb. 6:	Ordnerwahl
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und es daher schnell unübersichtlich wird (Abb. 6). Für die Analysen greift das 
Programm automatisch auf diesen Ordner zu und zeigt die zur Verfügung stehen-
den Programmdateien an. Bei der Durchführung von Berechnungen werden die 
Ergebnisse wiederum im Projektordner gespeichert. Daher sind die Output-Dateien 
im Feld „Output“ sinnvoll umzubenennen, weil diese bei Anwendung derselben 
Funktion sonst wieder überschrieben werden. 

DATENEINGABE

Um Berechnungen mit UCINET durchzuführen, ist es zunächst erforderlich, dass 
die erhobenen Daten im programmeigenen Format vorliegen. Um einen Datensatz 
in UCINET zu erstellen, stehen verschiedene Möglichkeiten zur Auswahl.

Eingabe per UCINET Spreadsheet oder per Excel

Unter Data > Data Editors > Matrix Editor wird das UCINET Spreadsheet geöffnet, 
in dem die erhobenen Daten als Matrix direkt eingegeben werden können. In die 
grau unterlegte Spalte werden die Bezeichnungen der Knoten eingetragen. Die 
Spalte wird markiert und mit Edit > Copy kopiert. Dann wird bei einer quadra-
tischen Matrix mit Transform > Transpose die Spaltenbezeichnung in die grau 
unterlegte Zeile geschoben. Markiert man jetzt die zweite Zelle der grauen Spalte 
und klickt auf Edit > Paste haben Zeilen und Spalten dieselbe Reihenfolge in der 
Bezeichnung (Abb. 7).19

Alternativ können Matrizen in Excel oder vergleichbaren Programmen erstellt 
werden und per copy & paste in das UCINET-Spreadsheet eingefügt werden.20 
Im Spreadsheet wird die Matrix unter File > Save As in dem zuvor erstelltem 
Projektordner als UCINET-Datei gespeichert.

19 Die Voreinstellung liegt bei 30x30 Knoten und muss für größere Netzwerke geändert werden.
20  Formelbasierte Zahlenwerte aus einer Excel-Matrix können von UCINET nicht gelesen werden → Umformatieren!

Abb. 7:	UCINET Spreadsheet
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Eingabe per Liste (nodelist und edgelist)

Eine weitere Möglichkeit ist die Eingabe von Daten per Liste. Hierfür kann der 
Microsoft Editor o. ä. verwendet werden. Gegenüber der Eingabe per Spreadsheet 
haben die hier vorgestellten Listenformate den Vorteil, dass auch Netzwerke mit 
einer großen Anzahl von Knoten übersichtlich bleiben. So werden in den hier 
vorgestellten Formaten nodelist und edgelist nur aktive Relationen eingegeben, 
d. h. alle Knotenpaare, die keine Beziehung haben, brauchen nicht eingetippt 
zu werden.21

nodelist-Format

Das nodelist-Format ist speziell geeignet, um ungewichtete Relationen einzugeben. 
Zur Notation der Befehlssyntax: dl steht für data language. Diese Angabe ist erfor-
derlich und wird als erstes genannt. format gibt das Layout der folgenden Daten 
an. Das n steht für die Anzahl der Knoten im Netz, labels: gibt die Bezeichnung 
der Knoten an. Setzt sich diese aus mehr als einem Wort zusammen, müssen 
diese Bezeichnungen in Anführungszeichen gesetzt werden (z. B. bei Vor- und 
Nachnamen). Unter data: werden die erhobenen Relationen zwischen den Knoten 
eingetragen. Die Ziffern sind der indexikalische Zugriff auf den Knoten, der unter 
labels an dieser Listenposition steht. Die erste Ziffer jeder Zeile ist die Position, 

von der die Relation ausgeht. Die weiteren Ziffern geben die Lis-
tenpositionen der Knoten an, mit denen diese Relation besteht. 
Es ist zu beachten, dass die Daten gerichtet eingegeben werden 
(d. h. an erster Position steht immer derjenige Knoten, von dem 
die Beziehung ausgeht). Die Ziffern werden durch Leerzeichen 
oder Kommata getrennt.22 Das Beispielnetzwerk (Abb. 8) besteht 
aus zehn Knoten und deren ungewichteten Beziehungen unter-
einander.23 So hat Knoten 1 Scott Pi eine Verbindung zu allen 
Akteuren außer Envy A und Julie Po, diese Verbindungen wer-
den von den entsprechenden Akteuren jeweils erwidert. Knoten 
10 Julie Po hat eine Beziehung zu Scott Pi, die dieser jedoch 
nicht erwidert. Bei diesem Beispiel handelt es sich daher um ein 
gerichtetes Netzwerk. 

21 Es gibt noch weitere Formate, die in der UCINET-Hilfe zu finden sind und dort erklärt werden.
22 Die Reihenfolge mit der die „Wahlen“ eingegeben werden, ist in dieser Form der Eingabe egal. Das erleichtert 
z. B. die Eingabe von ungeordneten Fragebögen.
23 Im nodelist-Format ist Gewichtung durch mehrfache Nennung eines Knotens pro Zeile möglich

Abb. 8:	nodlist-Format
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edgelist-Format

Das edgelist-Format ist speziell geeignet für die Eingabe von gewichteten Relationen 
(Abb. 9). Für die Formatierung muss an erster Stelle wieder dl, abweichend hier 
jedoch format=edgelist1 angegeben werden. Wie bei der nodelist, werden Anzahl 
(n) und Bezeichnung der Knoten (labels) aufgeführt. Bei der Ein-
gabe der Relationen unter data steht (wie beim nodelist-Format) 
die erste Ziffer für die Position in der Liste, von der die Relati-
on ausgeht. Die zweite Ziffer steht für die Position mit der die 
Relation besteht. Die dritte Ziffer gibt die Stärke der Beziehung 
an. Dabei muss –anders als im nodelist-Format (s.o) – für jedes 
Knotenpaar eine neue Zeile begonnen werden. Steht hinter den 
beiden Ziffern kein Wert, so wird von UCINET automatisch die 
Stärke 1 eingesetzt. Im Beispiel (Abb.9) handelt es sich um ein 
Netzwerk, in dem Scott Pi eine als stark (3,0) gewertete Verbin-
dung zu Ramona F aufweist, eine Verbindung der Stärke 2,0 zu 
Stacey Pi und jeweils eine schwache (1,0) Verbindung zu Kim P 
und Knives C. Zu den anderen Knoten im Netzwerk besteht keine 
Verbindung. (Beachten: nur ein Knotenpaar pro Zeile eingeben!)

In beiden Listenformaten (nodelist und edgelist) werden die 
Relationen gerichtet eingegeben (d. h., dass Knoten diejenigen Relationen, die 
andere Knoten mit ihnen haben, nicht zwangsläufig erwidern müssen. Auch die 
Stärke der Beziehungen wird unabhängig voneinander eingeben. Das heißt, dass 
Wertungen und Vorhandensein von Verbindungen zwischen den Akteuren u. U. 
voneinander abweichen). 

Die Editor-Dateien werden zunächst im Projektordner im Format *.txt gespei-
chert und stehen dann für den Import in UCINET bereit. 

Import von dl-Dateien in UCINET

Unter Data > Import text file > DL … kann die erstellte Liste jetzt eingelesen 
werden. Dafür wird über den Browser die entsprechende txt-Datei ausgewählt 
und geöffnet (Abb. 10).24 Der Dateiname wird vom Programm automatisch über-
nommen, kann aber auch geändert werden. Wenn der Vorgang mit OK bestätigt 
wird, erstellt UCINET zwei Programmdateien mit den Endungen *.##d und *.##h. 
Diese Dateien müssen sich immer in demselben Ordner befinden, da sie sonst 
nicht gelesen werden können. Dabei ist besonders zu beachten, dass die vom 
Programm neu erstellten UCINET-Dateien bereits vorhandene Dateien mit den-

24 Wenn man mehrere Dateien gleichzeitig importieren möchte, benutzt man > Multiple DL files.

Abb. 9:	edgelist-Format
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selben Dateinamen automatisch und ohne Vorwarnung überschreiben! Für die 
übersichtliche Organisation der Forschungsdaten ist es sehr zweckmäßig, eine 
systematische Nomenklatur für die bearbeiteten Programmdateien zu entwickeln 
(→ sinnvolle Dateinamen ausdenken!). 

Zur Kontrolle erscheint nach jeder Bearbeitung mit UCINET ein Output Log, der 
das Ergebnis anzeigt (Abb. 11).

Wenn die Daten in UCINET importiert wurden und im Projektordner als Pro-
grammdateien bereitliegen, kann in UCINET oder NetDraw weitergearbeitet werden.

NETDRAW

NetDraw ist ein Visualisierungsprogramm, das in UCINET implementiert ist und 
Netzwerke, die als UCINET-Datenssätze (*.##h) vorliegen, graphisch darstellen 
kann. Das Programm kann in UCINET entweder über die Symbolleiste oder über 
Visualize > NetDraw gestartet werden. 

Abb. 11:	Output-Log der Matrix

Abb. 10:	Import der erstellten Liste in UCINET
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In NetDraw wird der UCINET-Netzwerkdatensatz, der visualisiert werden soll, 
über File > Open > Ucinet dataset > Network geöffnet (Abb. 12). 

Der darzustellende Datensatz (*.##h) wird im Browser ausgewählt (Abb. 13). 
In NetDraw wird sodann die graphische Darstellung des Netzwerks erstellt. Das 
visualisierte Netzwerk besteht aus Knoten (hier mit Labels versehen) und Kan-
ten. Letztere sind als Linien dargestellt, wobei die Pfeilspitzen die Richtung der 
Relation anzeigen (Abb. 14). 
In der Standardeinstellung von NetDraw werden die Knoten zunächst ihren rela-
tionalen Merkmalen entsprechend anhand des sogenannten Spring-Embedding-Al-
gorithmus angeordnet. (Aktivere Knoten befinden sich im Zentrum, weniger aktive 
Knoten eher am Rand). 

Die Punkte in der Abbildung können anschließend manuell ausgewählt und 
per Drag & Drop verschoben werden. Knoten, die keine Verbindung im Netzwerk 
haben – sog. Isolates – werden am linken oberen Bildrand aufgelistet und können 
bei Bedarf aus der Abbildung entfernt werden (→ Symbolleiste Iso).  

Abb. 12:	Datei-Import in NetDraw

Abb. 13:	Quelle und Matrixformat
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Die erstellten Netzwerkgraphiken können unter File > Save Diagram As … auch 
als Bilddateien (z. B. *.jpg) gespeichert werden.25 Außerdem ist es mit NetDraw 
möglich, den zugrundeliegenden Datensatz zu verändern, indem Verbindungen 
oder Punkte gelöscht, hinzugefügt oder konvertiert werden. Der veränderte Daten-
satz ist dann unter File > Save Data As > Ucinet … zu speichern (Vorsicht: 
Umbenennen!). 

Die NetDraw-Visualisierung der in den folgenden Schritten behandelten Analysen 
(z. B. Zentralität, Gruppierung nach Attributen etc.) wird in den entsprechenden 
Abschnitten dieser Anleitung behandelt.

25 Für eine Bilddatei mit einer höheren Auflösung (z. B. für Abbildungen im Text) bietet es sich an, die Datei mittels 
der Druckfunktion im PDF-Format zu speichern, sofern ein entsprechendes Add-on installiert ist.

Abb. 14:	Graph mit Beschriftung und Richtung
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      EXKURS: MERKMALE VON INDIVIDUEN UND KOLLEKTIVEN

„Eine zentrale Hypothese der strukturellen Analyse ist es, dass die Einbet-
tung von Individuen [in Netzwerkstrukturen, d. Verf.] deren Verhalten und 
das Verhalten von größeren Einheiten beeinflusst. […] Zu unterscheiden 
ist zwischen mindestens zwei Analyseebenen und Merkmalsträgern: den 
Individuen und den Kollektiven“ (Jansen 2006: 52).

	 MERKMALE VON INDIVIDUEN:​

•	 Absolute Merkmale „hängen dem einzelnen Individuum […] an, 
ohne dass auf seine Einbettung in Beziehungsgeflechte oder in über-
geordnete Kontexte geschaut werden müsste“ (Jansen 2006: 53). In 
der Regel werden diese Merkmale als Attributsdaten der Akteure 
erhoben.

•	 Relationale Merkmale „setzen zwei oder mehr betrachtete Indivi-
duen oder Elemente voraus und kennzeichnen die Beziehungen eines 
Elements zu jeweils einem anderen Element. […] Relationale Merkmale 
sind streng genommen keine Merkmale des einzelnen Elements mehr, 
sondern eine Eigenschaft von Paaren, also sehr kleinen Kollektiven. 
Sie sind die wesentlichen Merkmale in der Netzwerkanalyse. […] 
[Sie] werden häufig an Individuen erhoben indem man z. B. nach 
ihrem Beziehungsnetz fragt“ (Jansen 2006: 54). 

•	 Komparative Merkmale „beruhen auf einem Vergleich der Merkmal-
sausprägung des betrachteten Elements mit einem analogen Merkmal 
des Kollektivs. […] Möglich sind solche Vergleiche zwischen Kollek-
tivmerkmalen und Individualmerkmalen sowohl auf Basis absoluter 
Merkmale als auch auf der Basis einiger relationaler Merkmale“ 
(Jansen 2006: 54). So z. B. Alter des Individuums im Vergleich zum 
Durchschnittsalter im Kollektiv usw. Hierzu gehören aber auch die 
errechneten Zentralitätswerte der Akteure, mit denen z. B. verglei-
chende Aussagen über deren Aktivität, Popularität oder die Kont-
rollfähigkeit im Netz getroffen werden können.

•	 Kontextuelle Merkmale „beruh[en] darauf, dass man ein Element 
aus dem Kollektiv dadurch beschreibt, welche Eigenschaften das Kol-
lektiv, also der Kontext aufweist. […] [Sie] sind, anders als die kom-
parativen Merkmale, für alle Individuen desselben Kontextes gleich“  
(Jansen 2006: 55).
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	 MERKMALE VON KOLLEKTIVEN:

•	 Analytische Merkmale „von Kollektiven sind solche Merkmale, die 
sich aus den absoluten Merkmalen der Kollektivmitglieder errechnen 
lassen“ (Jansen 2006: 56).

•	 Strukturelle Merkmale „sind solche Merkmale eines Kollektivs, die 
sich aus den relationalen Eigenschaften der Kollektivelemente errechnen 
lassen. […] Während die relationalen Merkmale das Rohmaterial 
sind, das für eine Netzwerkanalyse erhoben werden muss, sind die 
strukturellen Merkmale das eigentliche Ziel der Netzwerkanalyse“ 
(Jansen 2006: 56/57). Hier werden sowohl direkte als auch indirekte 
Beziehungsmuster untersucht und Aussagen über Cliquen, Positions-
strukturen und Rollengefüge gemacht.

•	 Globale Merkmale „sind solche Merkmale, die nicht auf die Merkmale 
der [Kollektiv]mitglieder zurückgeführt werden können“ 

	 (Jansen 2006: 57). 
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Schritt 2 – Erste Berechnungen: Dichte, 
Reziprozität und Subgroups

Im Folgenden werden erste Analyseverfahren zu strukturellen Merkmalen eines 
Netzwerks vorgestellt.

DICHTE

„Ein Beispiel für ein strukturelles Merkmal eines Kollektivs ist die Dichte in 
einem Netzwerk […]. Dies ist ein relativ simples Maß, das auf der Aufsum-
mierung aller Wahlen, bezogen auf die Zahl der möglichen Wahlen beruht“ 
(Jansen 2006: 57).

„Allgemein ist die Netzwerkdichte definiert durch das Verhältnis zwischen 
der Zahl der vorhandenen Linien zur Zahl der grundsätzlich möglichen“ 
(Jansen 2006: 94). 

Hinweis: Vgl. auch Trappmann et al. (2011: 253).

Mit der Berechnung der Netzwerkdichte (Density) erhält man erste Auskunft über 
die Beschaffenheit des Netzwerks. Es wird berechnet, wie viele Relationen der 
potentiell möglichen Verbindungen (n*[n-1]) tatsächlich im Netzwerk vorhanden 
sind. Der Wert ist demnach 1 bei maximal verbundenen Graphen und 0, wenn es 
sich bei den untersuchten Knoten ausschließlich um isolates handelt. (→ Je höher 
der Wert, desto größer die Dichte des Netzwerkes).

Für die Dichteberechnung in UCINET wird die zu untersuchende Matrix unter 
Network > Cohesion > Density Overall ausgewählt (Abb. 15). 

Abb. 15:	Dichteberechnung
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Bei der Interpretation des Dichtewertes ist zu beachten, ob es sich um ein sym-
metrisches Netzwerk handelt oder nicht. (Bei symmetrischen Netzen müssen die 
Verbindungen zwischen Knoten in beide Richtungen gezählt werden). Liegt ein 
gewichtetes Netzwerk vor, ergibt sich der Wert (Average Value) aus der Summe 
der Gewichtungen geteilt durch die Anzahl der maximal möglichen Beziehungen. 
Die Dichte ist der Durchschnittswert der binären Relationen – somit sind Density 
und Average Value identisch. In einem Output Log werden der Dichtewert (1.0 = 
100 %) und die Anzahl der Verbindungen aufgeführt. Diese Daten werden – wie 
alle Berechnungen – auch als Programmdateien (hier mit dem Suffix -density) 
im Default-Ordner gespeichert. 

REZIPROZITÄT

„With symmetric dyadic data, two actors are either connected, or they are 
not. Density tells up pretty much all there is to know. With directed data, 
there are four possible dyadic relationships: A and B are not connected, A 
sends to B, B sends to A, or A and B send to each other. A common inte-
rest in looking at directed dyadic relationships is the extent to which ties 
are reciprocated. Some theorists feel that there is an equilibrium tendency 
toward dyadic relationships to be either null or reciprocated, and that asym-
metric ties may be unstable. A network that has a predominance of null 
or reciprocated ties over asymmetric connections may be a more ‚equal‘ or 
‚stable‘ network than one with a predominance of asymmetric connections 
(which might be more of a hierarchy)“ (Hanneman, Riddle 2005: Kap. 8). 

Hinweis: Vgl. auch Jansen (2006: 61).

Reziprozität meint die Wechselseitigkeit von Beziehungen. Eine Relation ist dann 
reziprok, wenn z. B. Knoten A Knoten B in einer Relationsart als Partner angibt 
und Knoten B seinerseits in derselben Relationsart ebenfalls Knoten A nennt. 
Dies bezeichnet man auch als eine mutuelle Dyade. Bei symmetrischen Netzwer-
ken liegt qua definitionem eine 100%ige Reziprozität vor. Bestimmte Relationen 
sind per se symmetrisch (z. B. Verwandtschaft, Ehe)26; sie sind ungerichtet und 
damit auch reziprok. Bei gerichteten Relationen (z. B. Hilfeleistung) ist es u. U. 
inhaltlich von Interesse, den Grad der Reziprozität zu berechnen. 

Mit Network > Cohesion > Reciprocity wird ein Netzwerk auf seine Reziprozität 
geprüft. Die Voreinstellungen ermöglichen es, u. U. einzelne Zeilen und Spalten 
der Matrix nicht in die Analyse miteinzubeziehen (Abb. 16). 

26 Verwandte kann man sich ja bekanntlich nicht aussuchen, und auch Ehebeziehungen sind, obwohl hoffentlich 
frei gewählt, ebenfalls reziprok.
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Bestätigt man die Auswahl mit OK, erhält man wiederum einen Output Log 
(Abb. 17): Der Wert Hybrid Reciprocity gibt den Grad der Reziprozität des 
gesamten Netzwerks als Prozentwert an. Im Beispiel sind 56,3 % der Relationen 
reziprok. In der Ergebnisdatei wird außerdem für jeden Knoten aufgelistet, wie 
hoch der Anteil der reziproken Relationen ist (getrennt nach eingehenden und 
ausgehenden Beziehungen) (Abb. 17). Die ersten beiden Spalten geben an, wie hoch 
der jeweilige Anteil der symmetrischen und asymmetrischen (also der reziproken 
und nicht-reziproken) Relationen ist. Die Spalten 3 und 4 zeigen getrennt nach 
ausgehenden und eingehenden Verbindungen die proportional nicht-symmetri-
schen Relationen an. Spalten 5 und 6 geben den Anteil der Relationen an, die 
nicht erwidert werden.

Im Beispielnetz (Abb. 17) hat Ramona F nur Verbindungen, die erwidert wer-
den. Sie hat keine nicht-symmetrischen Verbindungen (siehe Spalte 2). Dagegen 
sind ein Viertel von Scott Pis Verbindungen nicht reziprok. Scott Pi weist nur 

Abb. 16:	Reziprozitätsberechnung

Abb. 17:	Output-Log Reziprozität
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eingehende Verbindungen auf (Spalte 4). Diese belaufen sich auf ein Viertel aller 
insgesamt eingehenden Verbindungen (Spalte 6). 

Reziprozität lässt sich auch in NetDraw darstellen: Zunächst wird das Netzwerk 
ausgewählt. Unter Analysis > Reciprocal Ties werden die Darstellungsoptionen 
ausgewählt. 

Im Beispielnetzwerk sind die reziproken Relationen als rote Linien dargestellt. 
Sie sind zudem doppelt so dick gezeichnet wie die asymmetrischen blauen Ver-
bindungen (Abb. 18 und 19).

SUBGROUPS – BI-KOMPONENTEN, CUTPOINTS UND CLIQUEN

Das Identifizieren von Cliquen und (Bi-)Komponenten in einem Netz ist eine weitere 
wichtige Funktion der Netzwerkanalyse. Wie auch bei anderen SNA-Verfahren 
zur Ermittlung von Subgroups, wird hierbei untersucht, ob es Bereiche im Netz-

Abb. 18:	Reziprozitätsvisualisierung

Abb. 19:	Graph mit reziproken Verbindungen
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werk gibt, die intern besonders stark vernetzt sind, mit anderen Worten, ob im 
Netzwerk Clusterungen feststellbar sind. 

Die Bi-Komponentenanalyse zielt darauf ab, sog. cutpoints im Netzwerk ausfindig 
zu machen. Cutpoints sind Knoten, bei deren Wegfallen das Netzwerk in mehrere 
Subkomponenten zerbrechen würde.

„In einem Graphen nennt man solche Knoten, ohne deren Vorhandensein der 
Graph in unverbundene Teile zerfallen würde, cutpoints. Solche Personen 
haben Einfluss auf das Zustandekommen von Interaktion oder Kommunikation 
zwischen den Teilpopulationen und können den Inhalt von Kommunikation 
kontrollieren und verändern“ (Trappmann et al. 2011: 54).

Mithilfe der UCINET-Funktion Network > Regions > Bi-Components können die 
cutpoints in einem Netzwerk identifiziert werden. Im Output Log wird Auskunft 
über die Anzahl der Bi-Komponenten und deren Zusammensetzung gegeben. 
Zudem wird aufgelistet, welche Knoten als cutpoints fungieren. 

Cliquen sind Bereiche maximaler Dichte in einem Netzwerk.

„Eine graphentheoretische Clique ist eine Gruppe von mindestens drei Akteu-
ren, die alle direkt miteinander verbunden sind“ (Jansen 2006: 195).

„Eine Clique ist ein maximaler vollständiger Teilgraph. Innerhalb einer 
Clique sind also alle Knoten durch einen Pfad der Länge 1, d. h. direkt 
verbunden. Bei Hinzunahme eines beliebigen weiteren Knotens geht diese 
Eigenschaft jedoch verloren. Um Triviale Cliquen auszuschließen, die nur 
aus zwei Knoten und einer Kante zwischen ihnen bestehen, legt man fest, 
dass eine Clique aus mindestens drei Knoten zu bestehen hat“ (Trappmann 
et al. 2011: 76). 

Hinweis: ausführlich in Scott (2011: 16; 117 ff.).

Die Cliquenberechnung wird unter Network > Subgroups > Cliques … durch-
geführt. Für ungerichtete Graphen gilt, dass eine Clique ein Set von mindestens 
drei Knoten ist, die alle untereinander direkt verbunden sind (d. h. maximal 
vollständig).

Für die Identifikation von Cliquen in sehr dichten und großen Netzwerken, die 
über eine große Anzahl von Dreier-Cliquen verfügen, kann die minimale Mitglie-
derzahl aber auch heraufgesetzt werden (Minimum size), um so beispielsweise 
nur Cliquen mit einer Mindestmitgliederzahl von vier Knoten zu berücksichtigen 
(Abb. 20).
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Der Output-Log zeigt die jeweiligen Cliquen und deren Mitglieder an (Abb. 21). 
Zu beachten ist, dass für die Cliquendefinition die Verbindungsrichtung durchaus 
eine Rolle spielt. So sind im Beispiel lediglich zwei Cliquen vorhanden, weil die 
Beziehung zwischen Kim P und Young Neil keine gegenseitige ist (siehe Clique 
Participation Scores). 

In einer Kreuztabelle (Co-Membership Matrix) werden die Ko-Mitgliedschaften 
der einzelnen Knoten aufgeführt. Die Diagonale gibt Aufschluss darüber, in wie 
vielen Cliquen die einzelnen Akteure Mitglied sind. Die Vektoren der Knoten 
zeigen die Anzahl der Cliquen an, in denen das jeweilige Knotenpaar gemeinsam 

Abb. 20:	Cliquenberechnung

Abb. 21:	Cliquenmatrix
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Mitglied ist. Stephen S (Knoten 6) ist beispielsweise in zwei Cliquen mit Scott 
Pi, aber jeweils nur in einer Clique mit Kim P und Young Neil (Abb. 21).27

Zur Veranschaulichung können die Cliquen in einem Netzwerk in NetDraw graphisch 
hervorgehoben werden. Die Datei CliqueOverlap.##h zeigt an, welche Knoten 
zusammen in einer Clique sind. Wenn die Linien unter Properties > Lines … 
hervorgehoben werden, kann diese Darstellung über das übrige Netzwerk gelegt 
werden, um so einen Eindruck von der Cliquenstruktur im Gesamtnetz zu erhalten.

27 Weitere Angaben betreffen die Clusterung des Netzwerks in Cliquen oder die Überschneidung der Mitglieder 
zwischen den Cliquen.
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Schritt 3 – Netzwerktransformation: 
Symmetrisierung, Dichotomisierung, 
Aggregierung

Die Verfahren der Dichotomisierung und der Symmetrisierung sowie das Aggregieren 
von Relationen sind Matrixmanipulationen zur Komplexitätsreduktion. Zugunsten 
einer Vereinfachung gehen dabei bestimmte Netzwerkinformationen verloren. 
Symmetisierung bedeutet einen Verlust der Richtungsinformation, Dichotomi-
sierung einen Verlust der Gewichtungsinformation. 

SYMMETRISIERUNG

Es kann u. U. analytisch sinnvoll sein, Netzwerkrelationen nachträglich zu sym-
metrisieren: Soll bei einem Netzwerk die Richtung der Relationen vernachlässigt 
werden, symmetrisiert man es (→ aus einem gerichteten Netz wird so ein ungerich-
tetes).28 In UCINET wird unter Transform > Symmetrize … das entsprechende 
Netzwerk und die Methode nach der symmetrisiert werden soll, angegeben (Abb. 
22).29 Der Vorgang generiert einen neuen, nun symmetrischen Netzwerkdatensatz 
mit dem Suffix -Sym.

DICHOTOMISIERUNG

Soll bei einem Netzwerk die Gewichtung aufgehoben werden, wird dieses dicho-
tomisiert: Transform > Dichotomize ….30

Im Anschluss an die Dichotomisierung ist nur noch ersichtlich, ob eine Relation 
vorhanden ist oder nicht. Dies ist z. B. dann notwendig, wenn gewichtete und 
ungewichtete Netzwerkrelationen zusammengefügt werden sollen (siehe unten 

28 Werden beispielsweise Freundschafts- oder Kooperationsrelationen erhoben, kann eine u. U. aus der Befragung 
herrührende Ungleichheit der Angaben durch Symmetrisierung ausgeglichen werden. Oder: Will man für die Analyse 
eines Unterstützungsnetzwerks z. B. nicht mehr berücksichtigen, wer wem geholfen hat, sondern nur noch ob in 
den dyadischen Beziehungen unterstützt wird, dann symmetrisiert man.
29 Bei der Symmetrisierung nach Maximum erhalten beide Knoten eines Knotenpaares den jeweils höheren 
Vektorwert (bei ungewichteten Netzwerken beispielsweise den Wert 1), bei Minimum beide den niedrigeren Wert 
(bei ungewichteten Netzwerken beispielsweise den Wert 0).
30 Will man für die Analyse eines Unterstützungsnetzwerks z. B. nicht mehr berücksichtigen, wieviel Unterstützung 
(z. B. Geld) geleistet wurde, sondern nur ob überhaupt unterstützt wurde, dann dichotomisiert man.

Abb. 22:	Symmetrisierung
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Aggregierung). Die Dichotomization rule legt die Bedingung für die Dichotomisie-
rung des Netzwerkes fest. Das Beispielnetzwerk soll hier so transformiert werden, 
dass alle Werte größer als 0 (Cut-Off Operator: GT - Greater Than und Cut-Off 
Value: 0) zum Wert 1 umgewandelt werden (Abb. 21). Es wäre auch möglich, 
den Trennwert höher anzusetzen (z. B. Cut-Off Value: 1 bedeutet alle Werte >1 
werden behalten) oder z. B. nur diejenigen Relationen zu berücksichtigen, die 
genau 1 betragen (Cut-Off Operator: EQ [Equal]=1). Der Vorgang generiert 
Netzwerkdateien, die im Suffix den Operator und den Trennwert der Dichotomi-
sierung angeben (z. B. -GT0).

AGGREGIERUNG – ZUSAMMENFÜHRUNG VON NETZEN                                                                              
(MULTIPLEXITÄT)

Meist werden für eine Netzwerkuntersuchung mehrere Relationen erhoben (z. B. 
„Flirten“, „Geldleihen“, „Knutschen“). Diese können zu einem Datensatz zusam-
mengefügt werden, um so die relationsübergreifende Struktur des aggregierten 
Netzwerks analysieren zu können.31 Auf diese Weise kann die Multiplexität von 
Beziehungsgefügen erfasst und dargestellt werden. Multiplexität bedeutet, dass 
zwischen zwei gegebenen Knoten in der Summe der unterschiedlichen untersuchten 
Relationen mehr als eine Verbindung vorliegt. Liegt zwischen einem Knotenpaar 
lediglich eine der erhobenen Beziehungsarten vor, spricht man von Uniplexität.

Für die Zusammenführung ist es i. d. R. notwendig, dass die einzelnen Net-
ze in einheitlicher Form vorliegen. Sollen z.  B. gewichtete und ungewichtete 
sowie symmetrische und asymmetrische Netze zusammengefügt werden, ist es 
sinnvoll, die einzelnen Netzwerke vor der Aggregation zu transformieren – d. h. 
gegebenenfalls zu dichotomisieren und/oder zu symmetrisieren (s. o.). Durch das 
Zusammenfügen mehrerer Einzelnetze werden die Werte der einzelnen Relationen 
summiert (Matrixsummation). (Beachte: Nach der Zusammenfügung ist nicht mehr 
ersichtlich, auf welcher Relation der jeweilige Wert basiert. Fügt man gewichtete 
Netzwerke zusammen, lässt sich folglich nicht mehr differenzieren, ob es sich um 

31 Diesem Verfahren liegt eine Matrixsummation zugrunde.

Abb. 23:	Dichotomisierung
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sich bei einem Wert um die Intensität einer Relation handelt oder um die Summe 
aus mehreren Relationen).32

In UCINET wird mit Transform > Matrix Operation > Between datasets > 
Statistical summaries (Abb. 24) das Dialogfenster geöffnet, welches das Zusam-
menfügen von einzelnen Netzen ermöglicht (Abb. 25). Für die Aggregation der 
Netzwerke ist vorausgesetzt, dass Reihenfolge, Anzahl und Labels der Knoten 
absolut identisch sind, da die Netzwerke sonst vom Programm nicht als zusam-
mengehörig identifiziert werden. 

Da im Ergebnis ohnehin nicht mehr erkennbar ist, welche der zusammengefügten 
Beziehungstypen mit dem jeweiligen Vektorwert korrespondieren, ist die Reihen-
folge der Datasets im Inputfeld nebensächlich. Für die Speicherung des neuen 
zusammengefügten Netzwerkdatensatzes ist eine sinnvolle Benennung angeraten, 

32 Bei gewichteten und asymmetrischen Relationen ist die Reihenfolge der Transformation u. U. bedeutend, wenn 
bspw. nicht nach Minimum symmetrisiert und im Anschluss dichotomisiert wird.

Abb. 24:	Programmpfad zum Zusammenführen von Netzen

Abb. 25:	Zusammenführen von Netzen
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da nach Abschluss der Transformation aus dem Datensatz nicht mehr ersichtlich 
ist, welche Relationen aggregiert wurden.33 Die Dateiendung bda-Sum zeigt an, 
dass es sich um eine between-datasets-aggregation handelt. (Beachte: diese Endung 
sollte bei der Dateiumbenennung beibehalten werden.) 

Im Output Log wird das Ergebnis der Matrixsummation dargestellt (Abb. 26). Beim 
Zusammenfügen von drei ungewichteten Relationen ist der maximale Wert einer 
Verbindung 3. Im Beispielnetzwerk (Abb. 27) sind z. B. die Verbindungen zwi-
schen Scott Pi und Ramona F oder Scott Pi und Wallace W dreifach multiplex, 
d. h., dass sie auf allen drei erhobenen Ebenen in Beziehung zueinander stehen. 
Eine Verbindung zwischen zwei Knoten, die nur in einem der Netzwerke besteht 
(Vektorwert 1), nennt man „uniplex“. Man beachte, dass bei der Zusammenfügung 
nicht-symmetrischer Netze im Ergebnis unklar bleibt, ob eine Beziehung auf einer 
Ebene reziprok oder aus der Kombinationen verschiedener Ebenen hervorgegangen 
ist (→ Netzwerke im Zweifel vorher symmetrisieren!).

Das generierte Netzwerk ließe sich natürlich auch noch weiter transformieren. 
Beispielsweise könnten mittels Dichotomisierung jene Beziehungen zwischen Knoten 
auf null gesetzt werden, die nicht multiplex sind (Dichotomization Rule: Greater 
Than; Cut-Off-Value: 1; alle Relationen > 1 = 1; alle Relationen < 1= 0). Bei 
weiteren Analysen würden dann nur noch die multiplexen Beziehungen berück-
sichtigt.

In der Darstellung in NetDraw kann Multiplixität – genau wie die Intensität (Stär-
ke) von Relationen – durch unterschiedliche Linienstärke visualisiert werden, um 
besonders starke Verbindungen zwischen Knoten hervorzuheben. Unter Properties 
> Lines > Size > Tie strength wird die Linienstärke erstellt (→ je „intensiver“, 
bzw. „mehrdimensionaler“ die Verbindung, desto dicker die Linie) (Abb. 27). 

33 Diese Information ist dann nur noch dem Output Log zu entnehmen.

Abb. 26:	Output-Log Matrix nach Aggregation
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TWO-MODE-MATRIZEN

Eine weitere Funktion der Zusammenfügung von Netzwerken kommt bei der 
Transformation von Two-mode-Matrizen zum Tragen. Two-mode-Matrizen (auch 
Ereignis-Matrizen genannt) stellen zunächst keine direkte soziale Beziehung dar. 
In ihnen wird die Teilnahme der Akteure an bestimmten Ereignissen (Events) auf-
gelistet. Z. B. werden Akteure nach der Teilnahme an bestimmten Veranstaltungen 
(Konferenzen, Tagungen, Seminaren, Raufereien) oder nach ihrer Mitgliedschaft 
in Gruppen (Vereine, Hobbygruppen, Räuberbanden etc.) gefragt. Mittels dieser 
Erhebung wird die gemeinsame Teilnahme an Events oder die gemeinsame Zuge-
hörigkeit zu Gruppen ersichtlich (Abb. 28). 

Abb. 27:	Multiplexer Graph in NetDraw

Abb. 28:	Spreadsheet 2-Mode-Matrix
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Daraus lassen sich ggf. Beziehungen ableiten/annehmen (z. B.: Zwei Akteure, die 
an demselben Seminar teilnehmen, kennen sich i. d. R.). 

Um aus einer 2-mode-Matrix eine 1-mode-Matrix (quadratische Matrix) zu generie-
ren, muss die 2-mode-Tabelle als Programmdatei vorliegen. Mit Data  Affiliations 
(2-mode to 1-mode) wird die 2-mode-Matrix konvertiert (Abb. 29). Das Suffix 
-Rows (in älteren Versionen -Aff) kennzeichnet die generierte Datei der Affiliation 
(= Mitgliedschaft, Zugehörigkeit) der Akteure (Zeilen) nach Events (Spalten). Das 
generierte Netz besteht jetzt – wie ein multiplexes Netz – aus mehreren „Eventre-
lationen“ und ist logischerweise symmetrisch. Die Anzahl der Events nach denen 
gefragt wurde, definiert die maximale Beziehungsstärke zwischen den Knoten.34 

Im Beispielnetzwerk war kein Knotenpaar an allen drei Events gemeinsam beteiligt. 
Es überschneiden sich hier nur jeweils zwei Teilnahmen (Abb. 30).

34 Zu beachten ist, dass die Diagonale der Matrix die Anzahl der Events angibt, an denen der Knoten beteiligt ist. 
Die Diagonale kann mit Transform > Diagonal… auf null gesetzt werden.

Abb. 29:	2-Mode-Matrizen-Konversion

Abb. 30:	Output-Log 2-Mode-Matrix-Konversion
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Schritt 4 – Zentralitätsmaße

Um Positionen von Akteuren im Netz zu untersuchen, ist die Berechnung von 
Zentralitätsmaßen nach Linton C. Freeman (1979, s. u. Textbox) die geläufigs-
te Herangehensweise der SNA.35 Die drei gängigsten Zentralitätsmaße sind die 
Degree-, die Closeness und die Betweeness-Centrality. Die Verfahren zu diesen 
netzwerkanalytischen Konzepten werden im Folgenden vorgestellt.

„Akteure, die überwiegend Objekt positiver gerichteter Beziehungen sind, 
haben ein hohes Prestige“ (Jansen 2006: 142).

„Zentralität und Prestige sind netzwerkanalytische Konzepte, die nach der 
Wichtigkeit, öffentlichen Sichtbarkeit oder ‚Prominenz‘ von Akteuren in 
Netzwerken fragen“ (Jansen 2006: 127).

„Ein Akteur in einem sozialen Netzwerk ist zentral, wenn er eine wichtige 
Stellung in dem sozialen Netzwerk einnimmt. Diese Wichtigkeit kann in 
der Menge seiner Beziehungen (degree centrality), in der Nähe zu ande-
ren Akteuren (closeness centrality) oder in seiner strategisch günstigen 
Lage zwischen anderen Akteuren (betweeness centrality) begründet sein“ 
(Trappmann et al. 2011: 266).

Hinweis: Zum Konzept der Zentralität in Netzwerken ausführlich in: 
Freeman (1979: 215–239). 

DEGREE-CENTRALITY

„Zwei Punkte heißen benachbart oder adjazent, wenn sie durch eine 
direkte Linie verbunden sind. […] Die Zahl der Punkte in der Nach-
barschaft des Punktes bestimmt seinen sogenannten Degree (degree of 
connection: Grad der Verbundenheit). […] Der Degree ist gleichzeitig 
schon ein einfaches Maß für die Zentralität eines Akteurs im Netzwerk“  
(Jansen 2006: 94 f., ausführlich ebd.: 132 f.).

35 Aus der Berechnung der Zentralitäten lassen sich auch Aussagen über strukturelle Merkmale wie Positionsstrukturen 
und Zentralisierung des Netzwerks treffen. Die Zentralisierung des Netzwerks gilt als Maß der Problemlösungskapazität 
und basiert auf den Konzepten der Akteurszentralität nach Freeman. Dabei gibt die Zentralisierung das Verhältnis 
zwischen dem zentralsten Akteur und allen anderen Akteuren an. Der Zentralisierungswert variiert zwischen „1“ 
(maximale Zentralisierung: entspricht einer Sternstruktur [sociometric star]) und „0“ (kein Unterschied in der Zentralität 
der Akteure: entspricht z. B. einer Kreisstruktur oder einem maximal verbundenen Graphen) (vgl. Jansen 2006: 138 ff.).
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„Indegrees und Outdegrees sind bereits einfache Maßzahlen für Prestige, 
Popularität oder Reputation sowie von sozialer Unterstützung von Akteu-
ren in Netzwerken. Indegrees messen, wie häufig ein Akteur von anderen 
‚gewählt‘ wird, Outdegrees messen, wie häufig ein Akteur ‚Wahlen‘ vergibt“ 
(Jansen 2006: 96).

Hinweis: Vgl. hierzu grundlegend Freeman (1979: 219 ff.).

Die Degree-Centrality (Gradzentralität) ist eine Maßzahl, welche die Aktivität 
eines Knoten im Netzwerk beschreibt. 

Die Gradzentralität gibt die Summe der Relationen an, die ein Akteur zu anderen 
Akteuren im Netz hat. Für die Berechnung des Degrees wird das zu untersuchende 
Netzwerk unter Network > Centrality and Power > Degree… über den Browser 
ausgewählt (Abb. 31). Es besteht die Möglichkeit, Netzwerke für die Untersuchung 
als symmetrisch zu betrachten. Die Methode, nach der symmetrisiert werden 
soll (Average, Minimum, Maximum), lässt sich jedoch nicht einstellen (Abb. 32). 

Grundsätzlich ist zu beachten, ob es sich um ein gewichtetes Netzwerk handelt 
oder nicht. Wenn der Zentralitätswert die Anzahl der Netzwerkpartner darstellen 
soll, ist es notwendig, das Netz zunächst zu dichotomisieren. Die Degree-Werte 
werden als Tabelle unter FreemanDegree gespeichert.36

36 Vorsicht: Es ist zu beachten, dass durch jede neue Berechnung bereits vorhandene Dateien mit dieser Bezeichnung 
ohne Warnung überschrieben werden. Daher ist es ggf. angeraten, die Dateibezeichnung anzupassen.

Abb. 31:	Programmpfad zur Degree-Berechnung

Abb. 32:	Degree-Berechnung
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Das erste Beispiel zeigt zunächst das Ergebnis der Degree-Zentralitätsberechnung 
eines symmetrisierten, binären (dichotomen) Netzwerks (Abb. 33): In der Spalte 1 
Degree wird die Aktivität der Knoten angezeigt, d. h. die Anzahl der Kontakte 
(Netzwerkpartner).37

Die Spalte 2 NrmDegree der Ergebnisdarstellung zeigt den normalisierten 
Degree. Dieser gibt das Verhältnis zwischen dem Degree des Knotens und der 
Anzahl der maximal möglichen Verbindungen als Prozentwert an.38

Die untere Tabelle zeigt zusätzliche deskriptive Statistiken. Außerdem wird die 
Network Centralisation (der Zentralisierungsgrad des Netzwerks) angegeben. 
Dieser Wert zeigt an, wie das Netzwerk im Hinblick auf das gewählte Zentralitäts-
maß strukturiert ist. Ein Zentralisierungsgrad von 100 % würde bedeuten, dass 
alle Verbindungen im Netz von einem Knoten ausgehen (dem sog. soziometrischen 
Star) und die übrigen Knoten untereinander keine Verbindungen hätten. Ein Wert 
von 0 % würde stattdessen bedeuten, dass alle Knoten den gleichen Degree haben 
und so keinerlei Hierarchie im Netz erkennbar wäre. Das Beispielnetzwerk hat 
einen Zentralisierungsgrad von 66,7 % (Abb. 33). In der Tabelle ist zu erkennen, 
dass Scott Pi als prominentester Knoten mehr als doppelt so viele Verbindungen 
hat wie der Durchschnitt im Netz, wohingegen die anderen Akteure größten-
teils weniger als die durchschnittliche Anzahl (und weniger als die Hälfte der 

37 Bei gewichteten (nicht dichotomisierten) Netzwerken wird die Stärke der Beziehung in die Berechnung einbezogen 
(summiert). Deshalb ist dem Degree-Wert nicht zu entnehmen, ob es sich um viele Verbindungen mit unterschiedlichen 
Knoten oder um eine geringere Anzahl von Verbindungen mit hoher Intensität handelt.
38 Für gewichtete Relationen sind die Werte NrmDegree und Network Centralisation zu vernachlässigen, da die 
Intensität der einzelnen Verbindungen die Mittelwertbildung verfälscht.

Abb. 33:	Output-Log Degree nach Freeman
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möglichen) Verbindungen aufweisen. Die Netzwerkstruktur ist daher eher als 
zentralisiert anzusehen.

Das zweite Beispiel (Abb. 34) bezieht sich auf ein Netzwerk mit asymmetrischen 
Verbindungen. Bei gerichteten Netzen wird bei der Berechnung der Gradzent-
ralität zwischen eingehenden und ausgehenden Beziehungen unterschieden: Der 
Outdegree gibt die Summe der ausgehenden Relationen eines Knotens an; der 
Indegree die Summe der eingehenden, d. h. er gibt an, wie oft der Knoten von 
allen anderen genannt wird. 

NrmOutDeg und NrmInDeg (Spalte 3 und 4 in Abb. 34) geben den prozentualen 
Anteil der realisierten Verbindungen an der maximal möglichen Anzahl an. So 
erhält Scott Pi zwei Verbindungen, welche er nicht erwidert, hat also einen höheren 
Indegree als Outdegree. Außerdem wird hier der Wert der Network-Centralisation 
(s. o.) angegeben. Im Vergleich zum symmetrischen Netzwerk (Abb. 33) verringert 
sich der Zentralisierungsgrad gemessen am Outdegree, der Zentralisierungsgrad 
nach Indegree ist jedoch noch einmal gestiegen, da Scott Pi im Verhältnis zu den 
anderen Akteuren noch mehr eingehende Verbindungen aufweist.

Abb. 34:	Output-Log In- & Outdegree
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CLOSENESS-CENTRALITY

„Dem Konzept der closeness centrality liegt die Idee zugrunde, dass eine 
Person dann zentral ist, wenn sie bezüglich der Netzwerkrelation sehr nah 
bei allen anderen liegt. Eine solche zentrale Lage steigert die Effizienz, 
mit der ein Akteur im Netzwerk agieren kann. Ein Akteur, der nah bei 
allen anderen liegt, kann zum Beispiel schnell Informationen verbreiten 
und empfangen. Für Freundschaftsnetzwerke steckt auch die Idee dahin-
ter, dass, wer sehr zentral in diesem Sinne ist, mit der Unterstützung 
vieler Netzwerkmitglieder rechnen kann“ (Trappmann et al. 2011: 48). 

Hinweis: Vgl. auch Freeman (1979: 224 ff.).

Die Closeness-Centrality der Akteure in einem Netzwerk errechnet man, indem man 
unter Network > Centrality > Closeness die Datei und das Verfahren (Type), 
nach dem die Closeness errechnet werden soll, auswählt (Abb. 35). 
Das Vorgehen ist das gleiche wie bei den übrigen Zentralitäten-Berechnungen. 
Bei der Closeness-Berechnung können jedoch unterschiedliche Verfahren der 
Errechnung verwendet werde. Die Standardvariante ist Freemans Sum of geodesic 
distances (Pfaddistanz).

Die geodätische Distanz (Pfaddistanz) ist die Länge des kürzesten Pfades 
zwischen zwei Knoten (vgl. Jansen 2006: 97; Trappmann et al. 2011: 48 f.). 

Die Pfaddistanzen der einzelnen Akteure zu allen anderen Akteuren werden sum-
miert und ergeben die Farness-Werte. Das Gegenstück zu Farness ist die Closeness. 
Je geringer die Farness eines Akteurs, desto näher ist dieser an den Mitgliedern 
im Netzwerk und daher umso zentraler. Die nCloseness gibt den prozentualen 
Zentralitätswert an. Für gerichtete Netzwerke werden In- und Out-Closeness 
errechnet. Will man das nicht, muss das Netzwerk zunächst symmetrisiert werden. 
Siehe oben. Es gilt zu beachten, dass die Closeness für Netze, die aus unverbunden 
Komponenten bestehen, nicht sinnvoll berechnet werden können, da die Pfadlänge 
bei Unverbundenheit theoretisch unendlich ist.39

39 Die Closeness wird dann i. d. R. nur für die Haupkomponente berechnet.

Abb. 35:	Closeness-Berechung
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Will man die durchschnittliche Distanz und damit den Netzwerkdurchmesser und 
die allgemeine Erreichbarkeit im Netzwerk untersuchen, ist die Funktion Network 
> Cohesion > Distance hilfreich. Diese Funktion errechnet unter anderem die 
durchschnittliche Pfadlänge (unter verbundenen Paaren) (Average Distance) 
und die Kompaktheit (Compactness) und „Breite“ (Breadth) des Netzwerks. 
Außerdem werden die Häufigkeiten der Pfadlängen (Fequencies of Geodesic 
Distances) für das Netzwerk sowie die Pfadlängen für alle Knotenpaare in einer 
Matrix angegeben.

BETWEENESS-CENTRALITY

„Das Konzept der betweeness centrality ist dazu geeignet, solche zent-
ralen Personen aufzuspüren, deren Zentralität weniger offensichtlich ist 
und die sich nicht unbedingt durch viele direkte Verbindungen auszeich-
nen. […] Personen, die zwei ansonsten unverbundene Teilpopulationen 
verbinden, sind typischerweise Akteure mit hoher betweeness centrality“ 
(Trappmann et al. 2011: 54).

„Betweeness-Zentralität misst […], ob andere Akteure vom betrachteten 
Akteur abhängig sind. Das Maß misst die Kontroll- und Profitmöglichkei-
ten, die dem Akteur aufgrund seiner strukturellen Position im Netzwerk 
zufallen“ (Jansen 2006: 135).

Hinweis: Vgl. auch Freeman (1979: 221 ff.); s. a. cutpoints.

Bei der Betweeness-Centrality gelten diejenigen Knoten als zentral, die besonders 
häufig auf den kürzesten geodätischen Pfaden der Verbindungen aller Knoten zu 
allen anderen Knoten liegen. Diese Positionen im Netzwerk lassen sich beispiels-
weise als Schnittstellen von Kommunikation begreifen; der Fluss von Informatio-
nen kann von hieraus kontrolliert und u. U. gelenkt werden. Aus dieser Analyse 
lassen sich mitunter Macht- und Manipulationspositionen ableiten. Cutpoints 
zwischen größeren Komponenten eines Netzwerks zeichnen sich beispielsweise 
durch hohe Betweeness-Centrality aus, da sie ansonsten unverbundene Teile von 
Netzwerken verbinden. 

Mit Network > Centrality > FreemanBetweeness > Node Betweenes wird die 
Analyseprozedur initiiert. Im Output Log (Abb. 36) zeigt der Betweeness-Wert 
(Spalte 1) an, wie oft sich ein Akteur auf dem kürzesten Pfad zwischen zwei belie-
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bigen anderen Akteuren im Netz befindet.40 Der Wert in Spalte 2 nBetweeness, 
gibt das prozentuale Verhältnis zwischen der jeweils realisierten und der maximal 
möglichen Betweeness an. Für das Beispiel bedeutet das, dass Knoten 1 der zen-
tralste Akteur in diesem Netzwerk ist. Er befindet sich auf 16,7 % der kürzesten 
Pfade. Für das Beispielnetzwerk bedeutet das, dass Scott Pi der zentralste Akteur 
in diesem Netzwerk ist. Er befindet sich auf 73 % der kürzesten Pfade. Der Zentra-
lisierungsgrad (67 %) deutet an, dass ein Großteil der Verbindungen über wenige 
(zentrale) Knoten verläuft, welche als Schlüsselfiguren betrachtet werden können. 

EXKURS: BRÜCKEN UND STRUKTURELLE LÖCHER

„Eine Brücke ist eine Linie, deren Entfernung den gleichen Effekt [wie das 
Entfernen eines cutpoints, d. Verf.] hat, aus einer Komponente mindestens 
zwei zu machen“ (Jansen 2006: 98). 
„Soziales Kapital erschließt sich vielmehr einem Akteur in einer Position, in 
der er als Brücke mehrere Cluster engerer Beziehungen miteinander verbindet. 
Damit überbrückt er ein strukturelles Loch. Solche Brücken über strukturelle 
Löcher sind allerdings regelmäßig auch weak ties“ (Jansen 2006: 187).

40 Ist mehr als ein kürzester Weg zwischen zwei Knoten vorhanden, so wird der Betweenesswert auf die entsprechenden 
Knoten, die auf den verschiedenen kürzesten Wegen liegen, proportional aufgeteilt.

Abb. 36:	Output-Log Betweeness nach Freeman



52 Einführung in UCINET und NetDraw in fünf Schritten

Hinweis: 
Zum Konzept der „Strukturellen Löcher“ ausführlich in: Burt (1992). 
Zum Konzept der „Weak Ties“ grundlegend in: Granovetter (1973: 1360–
1380, 1974).

ZENTRALITÄTEN IN NETDRAW

In NetDraw können die Zentralitäten von Knoten dargestellt werden (Knoten-
größe). Für das jeweils in NetDraw geladene Netzwerk werden unter Analysis > 
Centrality measures die Zentralitätsmaße berechnet. Es ist darauf zu achten, ob 
man die Zentralität differenziert nach In- und Outdegree oder als ungerichtet 
berechnen will (Einstellung unter Checkbox Direction). Die errechneten Zent-
ralitätswerte werden vom Programm automatisch als Attribute gespeichert und 
stehen dann für die attributsbezogenen Visualisierungen bereit. Unter Properties 
> Nodes > Symbols > Size > Attribute based können Knoten entsprechend 
der Zentralität größenmäßig hervorgehoben werden (Abb. 37).41

41 Zur graphischen Darstellung von Closeness ist es sinnvoll, die Werte in NetDraw umzukehren (Checkbox: attribute 
values), weil die Werte sich ansonsten auf die Farness (also das Gegenteil von Closeness) der Knoten beziehen.

Abb. 37:	Graph mit Hervorhebung der Zentralität



Schritt 5 – Attribute, Homophilie, QAP, CONCOR und Blockmodelle 53

Schritt 5 – Attribute, Homophilie, QAP, CONCOR 
und Blockmodelle

Für die Analyse und Interpretation eines Netzwerks bietet es sich an, die Attribute 
(absolute Merkmale) der Akteure zu berücksichtigen. Attribute werden gemeinhin 
bei der Erhebung der Netzwerke mit erfragt. Die Auswahl der zu erhebenden 
Attribute ist immer abhängig von der Fragestellung. Häufig werden allgemeine 
Angaben erhoben (Alter, Geschlecht, Beruf, Wohnort etc.). Die Akteure können 
entsprechend der Merkmalsausprägungen gruppiert bzw. analysiert werden.
Im Folgenden sollen zunächst Verfahren vorgestellt werden, wie Netzwerke un-
ter Berücksichtigung von Attributen analysiert werden können. Zudem werden 
Konzepte vorgestellt, mit deren Hilfe das Rollengefüge und die Positionsstruktu-
ren von Netzwerken untersucht werden.

EINLESEN VON ATTRIBUTSDATEN IN UCINET

Damit die Attributsdaten vom Programm bearbeitet werden können, müssen 
diese zunächst in UCINET eingelesen werden. Für das Einlesen/-geben gibt es 
verschiedene Wege: Entweder werden die Attributdaten direkt im UCINET-Spread-
sheet eingegeben und gespeichert, oder sie werden per copy & paste aus einer 
Excel-Datei in das UCINET Spreadsheet eingefügt (Abb. 38).42 Man beachte, dass 
die Attributdaten für UCINET numerisch codiert sein müssen, da diese ansonsten 
nicht vom Programm erkannt werden können. Die Daten werden anschließend 
in dem Default-Ordner als UCINET-Datenset gespeichert.43

42 Vorsicht: Daten die in Excel per Formel generiert worden sind, können nicht gelesen werden und müssen vor dem 
Import konvertiert werden. Es ist zwingend notwendig, dass die Attributsdatenmatrix genau dieselben Labelbezeichnungen 
(inkl. Reihenfolge) beinhaltet wie die Netzwerkdatenmatrix, da die Matrizen sonst nicht kompatibel sind.
43 Es ist möglich, Attributsdaten und Berechnungen aus UCINET zu exportieren, z. B. in Excel unter Data > Export 
> Excel.

Abb. 38:	Spreadsheet Attributstabelle
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HOMOPHILIE

Von Homophilie spricht man, wenn sich die Ähnlichkeit von Akteuren in Bezug auf 
bestimmte Merkmale (Attribute) auch in überzufälliger Weise in der Netzwerk-
struktur widerspiegeln. Mit diesem Begriff wird die in sozialen Beziehungen z. T. 
beobachtbare Tendenz beschrieben, dass Akteure, die ein bestimmtes Attribut 
gemeinsam aufweisen, stärker untereinander vernetzt sind, als mit den übrigen 
Akteuren im Netzwerk („Gleich und Gleich gesellt sich gern!“). Z. B. wäre in 
einem Ratgebernetzwerk denkbar, dass Ratschläge eher zwischen Akteuren des 
gleichen biologischen Geschlechts gegeben werden. Würde sich diese Hypothese 
bestätigen, würde man das Netzwerk bezüglich des Merkmals „Geschlecht“ als 
homophil bezeichnen.44

Die Homophilie-Analyse wird unter Network > Cohesion > Homophily durchge-
führt. Das zu untersuchende Netzwerk wird unter Network Dataset geladen. Im 
zweiten Feld wird die Programmdatei, welche die Attribute beinhaltet, geöffnet 
und im Dialogfeld die Spalte ausgewählt, in der sich das Attribut befindet und 
anhand dessen das Netzwerk partitioniert – d. h. gruppiert – werden soll (Abb. 39). 

Im Output Log wird eine Kreuztabelle aufgeführt, in der die Knoten mit dersel-
ben Attributsausprägung zusammengefasst sind (Abb. 40). Der E-I-Index gibt die 
Homophilie für das gesamte Netzwerk an. Der Index gibt an, wie das Verhältnis 
der Verbindungen zwischen und innerhalb der nach diesem Attribut gruppierten 
Knoten beschaffen ist. Grob gesprochen können Netzwerke mit Werten zwischen 
-0.5 und -1 als homophil und solche mit Werten zwischen 0.5 und 1 als heterophil 
gedeutet werden. Das Beispiel zeigt eine Unterteilung in zwei gleichgroße Grup-

44 Das ebenfalls vorstellbare Gegenteil von Homophilie nennt sich Heterophilie.

Abb. 39:	Homophilie-Berechnung
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pen. Die Gruppe der Musiker ist stark verbunden. Das Netzwerk ist neutral (siehe 
E-I-Index = -0,04). Die Restgruppe ist untereinander weniger verbunden als mit 
den Mitgliedern der anderen Gruppe, wodurch ihre Homophilie aufgehoben wird.

QUADRATIC ASSIGNMENT PROCEDURE (QAP) 

Die Quadratic Assignment Procedure (QAP) ist eine Methode zum Testen von 
Hypothesen. Dafür wird eine Korrelation (Pearson r-Koeffizient) zwischen einer 
Netzwerkrelation und einem Attribut berechnet (z. B. ließe sich für ein Konfe-
renzteilnehmerInnen-Netzwerk untersuchen, ob ein statistischer Zusammenhang 
zwischen dem Attribut „Raucher/Nichtraucher“ und der Relation „Small-talk“ 
vorliegt). Für diese Analyse ist es zunächst notwendig, die zu analysierende Attri-
butsvariable in eine Ähnlichkeitsmatrix zu konvertieren. D. h., dass – ähnlich wie 
bei Two-mode-Matrizen (s. o.) – diejenigen Akteure eine „Verbindung bekommen“, 
welche die Merkmalsausprägung bei einem bestimmten Attribut teilen. Dafür wird 
unter Data > Attribute to Matrix im Dialogfenster der Attributsdatensatz geöffnet 
(Abb. 41). Danach werden das Attribut und die Bedingung (z. B. Exact Matches), 
nach der die Verbindung zustande kommen soll, ausgewählt. 

Das Ergebnis ist eine Matrix, in der eine Übereinstimmung mit 1 codiert und 
als Datei mit dem Attributscodes als Zusatz gespeichert wird (in älteren Versionen 
mit dem Suffix -mat).

Abb. 40:	Output-Log Homophilie-Berechnung
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Im nächsten Schritt wird die QAP-Funktion unter Tools > Testing Hypotheses 
> Dyadic (QAP) > QAP Correlation geöffnet. Hier werden das zu untersuchende 
Netzwerk und die aus dem Attribut erzeugte Matrix (*-mat) geladen (Abb. 42). 
Das Ergebnis liefert eine Korrelation nach Pearson: die Werte können zwischen 
1 (positive Korrelation) und -1 (negative Korrelation) liegen. 

In der Beispielberechnung (Abb. 43) liegt zwischen den Netzwerkrelationen und 
dem Attribut „Musiker“ keine Korrelation vor (vergleiche Homophilie). Der Sig-
nifikanzwert liegt jedoch über 0,05 % Fehlerwahrscheinlichkeit (95 %-Niveau), 
sodass die Analyse hier ohnehin nicht aussagekräftig ist.

Abb. 41:	Erstellung „Attributsnetzwerk“

Abb. 42:	QAP-Berechnung
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ROLLEN UND POSITIONEN – CONCOR

„[Bei] der Analyse von Positionen [werden] solche Akteure gesucht, die ein 
ähnliches Muster von Beziehungen aufweisen und somit in ähnlicher Weise 
in das Netzwerk eingebunden sind. Rollen schließlich beziehen sich auf das 
Muster der Beziehungen zwischen Angehörigen gleicher oder verschiedener 
Positionen“ (Trappmann et al. 2011: 101).

„Das Konzept der Äquivalenz stellt zwar theoretisch eine Formalisierung 
des Konzeptes der Position dar, ist jedoch häufig nicht praktikabel […]. 
Daher ist es zweckmäßig, Formalisierungen des Positionenkonzeptes zu 
verwenden, die weniger restriktiv sind als das Konzept der Äquivalenz“ 
(Trappmann et al. 2011: 114).

„CONCOR bedeutet ‚Convergence of iterated correlations‘. […] Die Ähnlichkeit 
von zwei Akteuren als Indikator für eine mögliche strukturelle Äquivalenz 
wird über die Korrelation zwischen den beiden Datenvektoren dieser Akteure 
erschlossen“ (Jansen 2006: 226).

Hinweis:
Zu CONCOR vgl. ausführlich: Breiger; Boormann; Arabie (1975).
Zu Blockmodellen und struktureller Äquivalenz vgl. Jansen (2006: 212 ff.).

Abb. 43:	Output-Log QAP-Analyse
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Der CONCOR-Algorithmus ist ein Verfahren, um strukturell äquivalente Positionen 
in einem Netzwerk zu ermitteln. Unter Network > Roles & Positions > Structural 
> CONCOR wird zunächst wieder das zu analysierende Netzwerk ausgewählt. 
Bei den Voreinstellungen kann angegeben werden, ob sowohl eingehende als auch 
ausgehende „Wahlen“ Berücksichtigung finden sollen (Abb. 44). Wird die Option 
Include transpose bejaht, werden auch die eingehenden Wahlen mitgezählt.

Grundsätzlich ist das Verfahren mehrstufig, d. h., dass die im Folgenden beschrieben 
Sortierung beliebig oft durchgeführt werden kann (Einstellung unter Max depth 
of splits (not blocks); standardmäßig sind drei Partitionsebenen vorgesehen) 
(Abb. 45).45 Dabei werden Akteure mit gleichem bzw. ähnlichem Beziehungsmuster 

45 Method of handling self ties bestimmt den Umgang mit den Werten der Diagonale; Convergence criteria gibt die 
Toleranz für die Gruppierung an; Maximum iterations bestimmt wie oft der Algorithmus über die Korrelationsmatrix 
laufen soll.

Abb. 44:	CONCOR-Verfahren Voreinstellungen

Abb. 45:	Output-Log CONCOR 1 – erste Korrelationsmatrix und Partition
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im Netzwerk auf Basis eines Korrelationsverfahrens identifiziert und entsprechend 
gruppiert. Die Beziehungsmuster der Akteure werden hierbei in Bezug auf ihr 
„Wahl“-Verhalten verglichen, d. h. es wird immer für zwei Akteure ermittelt, ob 
sich deren Beziehungen zu den übrigen Akteuren in Form und Anzahl ähneln.46 
Für jedes Knotenpaar wird angegeben, wie ähnlich sich die Akteure in Bezug auf 
ihre Beziehungsmuster sind. Die Ähnlichkeit wird anhand eines Werts zwischen 
+1 und -1 indiziert. Die errechneten Werte werden in der Initial Correlation 
Matrix aufgeführt und in der Datei Concor1stCorr gespeichert. Ein Wert von 
+1 bedeutet, dass zwei Akteure die gleiche Anzahl von Relationen zu denselben 
anderen Akteuren haben. Sie wären dann strukturell äquivalent (Abb. 38). Auf Basis 
dieses Wertes werden die Akteure im ersten Schritt in zwei Blöcke sich ähnelnder 
Akteure gruppiert. Diese Prozedur wird automatisch wiederholt (entsprechend 
der angegebenen Max depth of splits [s. o.]), so dass mit jedem Mal die „Ver-
ästelung“ (Abb. 47) fortschreitet und zunehmend „ähnlichere“ Akteure gruppiert 
werden. Im hier aufgeführten Beispiel – einem zufällig erstellten Netzwerk – ist 
das Netzwerk schließlich in drei Partitionsrunden in fünf Akteurspaare und zwei 
Einzelakteure gruppiert (Abb. 45). Im Partition Diagramm (Abb. 46) und im 
Dendogramm (Abb. 47) sind diese Partitionierungen abgebildet.

Die letzte Partitionierung wird zusätzlich in Form einer Kreuztabelle aufgeführt, 
welche die Anzahl der Verbindungen zwischen den Gruppen (Blocked Matrix) und 

46 Eine direkte Nachbarschaft der Akteure ist dabei nicht zwingend erforderlich.

Abb. 46:	Output-Log CONCOR 2
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die jeweilige Dichte für die Blöcke (Density Matrix) anzeigt. Der Korrelationswert 
R-squared gibt schließlich an, wie genau die vorgenommene Clusterbildung die 
tatsächliche Struktur des Netzwerks abbildet. Werte ab 0,7 gelten gemeinhin als 
statistisch aussagekräftig. Ramona, Wallace und Stacey sind durch ihr Verhältnis 
zu Scott ähnlich in ihren Netzwerkrollen. Kim, Stephen und Neil sind zwar auch 
mit Scott verbunden, durch ihre Verbindungen untereinander unterscheiden sie 
sich jedoch vom erstgenannten Block. Der Korrelationswert im Beispiel beträgt 
0,7. Es ist daher anzunehmen, dass die Cluster eine gute Repräsentation der tat-
sächlichen Struktur des Netzwerkes darstellen (Abb. 43). 

BLOCKMODELLE

Netzwerke lassen sich mit Hilfe von Blockmodellen mitunter anschaulich visua-
lisieren. Bei Blockmodellen können Akteure entweder aufgrund ähnlicher Positi-
onen im Netzwerk gruppiert werden (a posteriori block models) oder die Akteure 
werden bereits im Vorfeld anhand bestimmter Attribute zusammengefasst (a prori 
block models). Die Verbindungen in den Blockmodellen stellen die gebündelten 
Beziehungen zwischen diesen Akteursgruppen dar.47

Mit der Blockbildungsfunktion in UCINET (Transform > Aggregate > Block …) 
werden die Akteure des Netzwerks anhand selbstgewählter Parameter in Gruppen 
(Blöcke) unterteilt. 

Daraufhin wird die Vernetzung innerhalb und zwischen diesen Gruppen, ähnlich 
wie bei der Untersuchung nach Homophilie, angezeigt. Diese „Block“-Funktion 
berechnet außerdem automatisch die Dichte der gebildeten Gruppen (dieses Ver-
fahren ist identisch mit der Funktion Network > Cohesion > Density > Density 

47 Instruktiv zu Blockmodellen: HEIDLER, R. (2006): Die Blockmodellanalyse – Theorie und Anwendung einer 
netzwerkanalytischen Methode. Wiesbaden: Deutscher Universitätsverlag.

Abb. 47:	Diagramm zu Ähnlichkeiten der Positionen im Netzwerk
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by Groups). Für dieses Verfahren können, wie oben beschrieben, Parameter selbst 
gewählt werden (z. B. aus erhobenen oder aus errechneten Attributen).

Es wird aus der Attributstabelle ausgewählt, nach welchem Parameter UCINET 
die Klassifikation vornehmen soll. Unter Input data wird zunächst der Datensatz 
des zu untersuchenden Netzwerks geladen. Unter Row- bzw. Block partition 
werden die Attributstabelle und die Spalte (Col #), nach der die Klassifikation 
erstellt werden soll, ausgewählt (Abb. 48).48 

48 Alternativ ist es möglich, die Akteure manuell zu partitionieren, indem man die Knoten der Reihe nach einer 
Gruppe zuweist („11212“ würde entsprechend bedeuten, dass die Knoten 1, 2, 4 Gruppe 1 und die Knoten 3, 5 der 
Gruppe 2 zugeordnet werden).

Abb. 48:	Block-Bildung

Abb. 49:	Output-Log Blockmodel
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In der Datei Blocked.* bzw. im Output-Log wird die Blockmatrix dargestellt. Hier 
sind die gruppierten Akteure und ihre Verbindungen untereinander bzw. mit den 
Mitgliedern der anderen Gruppen aufgeführt (Abb. 49). Zudem werden in einer 
weiteren Kreuztabelle zum einen die Dichtewerte für die einzelnen Blöcke und 
zum anderen für die Blöcke übergreifenden Verbindungen angegeben (Reduced 
Blockmatrix).
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EINFÜHRUNGSLITERATUR ZUR SOZIALEN NETZWERKANALYSE

Es gibt mittlerweile ein recht breites Spektrum an Einführungsliteratur zur SNA. 
Keines der bisher vorliegenden Werke kann jedoch als allumfassend angesehen 
werden. Als Orientierungshilfe möchten wir deshalb zum Abschluss unseres Hand-
buchs einen Überblick über das derzeitige Angebot an Lehr- und Einführungs-
büchern geben. Es soll darum gehen, einen schnellen Einblick in die inhaltliche 
Ausrichtung der jeweiligen Bücher zu geben, damit der/die LeserIn entscheiden 
kann, welche der vorgestellten Publikationen den eigenen Bedürfnissen am bes-
ten entsprechen.

Wir orientieren uns dabei an dem gelungenen Beitrag von Mergel und Hennig 
(2010), der eine umfangreiche, tabellarische Darstellung der Einführungs-, Lehr- 
und Arbeitsbüchern, die bis 2006 auf dem Markt waren, bietet.49 Da seitdem 
zahlreiche neue interessante Titel erschienen sind, ist es bereits jetzt lohnenswert, 
das Literaturreview zu aktualisieren. Sowohl die Methodik der Systematisierung 
als auch die von Mergel und Hennig gewählten Vergleichskategorien behalten 
wir weitgehend bei (ausführlich zur Systematisierung und den Klassifikationskri-
terien: Mergel, Hennig 2010: 931 ff.). Zusätzlich zu den vierzehn bei Mergel und 
Hennig untersuchten Titeln haben wir elf Neuerscheinungen in das Review auf-
genommen und entlang derselben Kategorien erschlossen. Bei Neuauflagen von 
bereits im ersten Review aufgeführten Büchern haben wir die Inhaltsverzeichnisse 
hinsichtlich thematischer Neuerungen durchsucht und ggf. Ergänzungen bei den 
Kategorisierungen vorgenommen. Insgesamt flossen die folgenden 25 Titel in 
unsere Untersuchung ein:

49 MERGEL, I.; HENNIG, M. (2010): Lehrbücher der Netzwerkforschung. In: Stegbauer, C.; Häußling, R. (Hg.): Handbuch 
Netzwerkforschung. Wiesbaden: VS Verlag für Sozialwissenschaften, S. 931–939. Bei diesem Beitrag handelt es sich 
um eine Aktualisierung und Zusammenfassung des 2006 für die Deutsche Forschungsgesellschaft (DFG) verfassten 
Titels: Marktanalyse zu Netzwerkanalyse-Büchern. (abrufbar unter URL: http://www.hks.harvard.edu/netgov/files/
png_workingpaper_series/PNG07-001b_WorkingPaper_MergelHennig_GE.pdf, Stand 22.10.2012).
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  BRANDES, U.; ERLEBACH, T. (2005) (Hg.): Network analysis: methodological 
foundations. Berlin: Springer. 

CARRINGTON, P.; SCOTT, J.; WASSERMAN, S. (2009) (Hg.): Models and 
methods in social network analysis. Nachdruck. Cambridge: Cambridge 
University Press. 

DO NOOY, W.; MRVAR, A.; BAGATELJ, V. (2011): Exploratory Social Network 
Analysis with Pajek. 2. Auflage. New York: Cambridge University Press.

DEGENNE, A.; FORSÉ, M. (2006): Introducing social networks. Nachdruck. 
London: SAGE. 

FREEMAN, L. C. (2008) (Hg.): Social network analysis. Los Angeles: SAGE. 

FREEMAN, L. C. (1989) (Hg.): Research methods in social network analysis. 
Fairfax: George Mason University Press. 

GALASKIEWICZ, J.; WASSERMAN, S. (1994): Advances in social network 
analysis: Research in the social and behavioral sciences: Los Angeles: SAGE.

GAMPER, M.; RESCHKE, L. (Hg.): Knoten und Kanten – Soziale Netzwerkanalyse 
in Wirtschafts- und Migrationsforschung. Bielefeld.

GAMPER, M.; RESCHKE, L. (2012) (Hg.): Knoten und Kanten 2.0 – Soziale 
Netzwerkanalyse in Medienforschung und Kulturanthropologie. Bielefeld: 
transcript.

HENNIG, M. (2012) (Hg.): Studying social networks: a guide to empirical 
research. Frankfurt a. M.: Campus. 

HOLLSTEIN, B.; STRAUS, F. (2006) (Hg.): Qualitative Netzwerkanalyse: Konzepte, 
Methoden, Anwendungen. Wiesbaden: VS Verlag für Sozialwissenschaften. 

HOLZER, B. (2010): Netzwerke. 2. Auflage. Bielefeld: transcript. 

JANSEN, D. (2006): Einführung in die Netzwerkanalyse: Grundlagen, Metho-
den, Forschungsbeispiele. 3. überarb. Auflage. Wiesbaden: VS Verlag für 
Sozialwissenschaften.
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KADUSHIN, C. (2012): Understanding social networks: theories, concepts and 
findings. New York: Oxford University Press. 

KNOKE, D.; YANG, S. (2010): Social network analysis. 2. Auflage. Los Ange-
les: SAGE. 

NEWMAN, M. (2012): Networks: an introduction. Nachdruck. Oxford: Oxford 
University Press. 

PAPPI, F. U. (1987) (Hg.): Methoden der Netzwerkanalyse. München: Olden-
bourg. 

PRELL, C. (2012): Social network analysis: history, theory and methodology. 
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aler Netzwerke: Konzepte, Modelle, Methoden. 2. Auflage. Wiesbaden: VS 
Verlag für Sozialwissenschaften.

WASSERMAN, S.; FAUST, K. (2009): Social network analysis: methods and 
applications. Reprint. Cambridge: Cambridge University Press. 

WEYER, J. (2011) (Hg.): Soziale Netzwerke: Konzepte und Methoden der sozial-​
wissenschaftlichen Netzwerkforschung. 2. Auflage. München: Oldenbourg. 
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Abb. 50:	 Übersicht über Einführungs- und Lehrbücher zur SNA
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NETZWERKANALYTISCHE STUDIEN IN DER 
DEUTSCHEN HUMANGEOGRAPHIE 

Obwohl der Begriff des Netzwerkes spätestens seit der Phase der quantitativ 
ausgerichteten raumanalytischen Geographie des sog. spatial approach 
(„Raumwissenschaftlicher Ansatz“) ab den späten 1960er Jahren 
einen wichtigen Bestandteil verschiedener geographischer Modell- und 
Theorieentwicklungen bildet, blieb der Methodensatz der formalen 
SNA innerhalb der Geographie erstaunlicherweise lange Zeit ungenutzt. 
Erst in den letzten Jahren entstehen vermehrt empirische Arbeiten, 
die sich auf das Forschungsprogramm der quantitativen SNA stützen. 
Die Gesamtheit der in der deutschsprachigen Geographie vorliegenden 
netzwerkanalytischen Beiträge ist aber immer noch relativ übersichtlich.

In diesem abschließenden Teil des kleinen Handbuchs soll deshalb der Versuch 
unternommen werden, eine Zusammenschau netzwerkanalytischer Beiträge (und 
ihrer Autoren) in der deutschsprachigen Geographie zu wagen.50 Die Liste soll 
nicht primär im Sinne eines State of the Art gelesen werden, vielmehr sollen die 
aufgeführten Studien erstens als Anwendungsbeispiele methodisch inspirieren, 
und zweitens will die Liste die bisherige thematische Bandbreite andeuten.51 So 
wird gleichzeitig ersichtlich, in welchen humangeographischen Forschungsbe-
reichen die SNA bisher keine oder kaum Anwendung in der deutschsprachigen 
Geographie findet und wo es u. U. Nachholbedarf gäbe.

50 Die Beschränkung auf die deutschsprachige Geographie dient lediglich der Übersichtlichkeit. In den 
Literaturverzeichnissen der angeführten Beiträge finden sich zahlreiche Referenzen auf netzwerkanalytische Arbeiten 
internationaler Geographen, die z. T. als Vorreiter des Methodenimports in die Humangeographie gelten können.
51 Wir erheben mit der Auflistung keineswegs den Anspruch, die publizierte Literatur vollständig abzubilden. Wir 
danken an dieser Stelle Tom Brökel (Universität Hannover), Pascal Goeke (Universität Zürich), Stefan Hennemann,  
Ingo Liefner (Universität Gießen), Ivo Mossig (Universität Bremen), Johannes Glückler (Universität Heidelberg)  und 
Peter Weichhart (Universität Wien) für ihre wertvollen Tipps und Literaturhinweise. Die ergänzend aufgeführten 
Titel sind das Resultat von Recherchen in sozialwissenschaftlichen und geographischen Fachdatenbanken. Sollten 
Leser dieser Zusammenstellung ihre Publikationen unberücksichtigt finden, so bitten wir dies mit einem Verweis 
auf die ausgewählten Datenbanken und verwendeten Suchschlüssel zu entschuldigen. Über weitere (Literatur-)
Hinweise würden sich die Autoren dieses Handbuchs sehr freuen.
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NETZWERKANALYTISCHE STUDIEN IN DER 
DEUTSCHEN HUMANGEOGRAPHIE

BRANDT, A. (2009): Metropolitan Regions in the Knowledge Economy: Network 
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LiT-Verlag. 

BRÖKEL, T.; HARTOG, M. (2011): Explaining the Structure of Inter-organiza-
tional Networks using Exponential Random Graph Models: does Proximity 
Matter? Papers in Evolutionary Economic Geography. =1107. (abrufbar 
unter URL: http://econ.geo.uu.nl/peeg/peeg1107.pdf, Stand 22.10.2012).

BRÖKEL, T.; BOSCHMA, R. (2011): The Cognitive and Geographical Composi-
tion of Ego-Networks of Firms – and how they impact on their Innovation 
Performance. Papers in Evolutionary Economic Geography =1118. (abrufbar 
unter URL: http://econ.geo.uu.nl/peeg/peeg1118.pdf, Stand 22.10.2012).

BRÖKEL, T.; BOSCHMA, R. (2011): Aviation, Space or Aerospace? Exploring 
the Knowledge Networks of two Industries in the Netherlands. In: European 
Planning Studies. 19, S. 1205–1227.

FORNAHL, D.; BRÖKEL, T.; BOSCHMA, R. (2011): What drives Patent Perfor-
mance of German Biotech Firms? The impact of R&D subsidies, knowledge 
networks and their location. In: Papers in Regional Science. 90, S. 395–379.

FRITSCH, M.; GRAF, H. (2011): How Sub-National Conditions affect Regional 
Innovation Systems: The Case of the two Germanys. In: Papers in Regional 
Science. 90, S. 331–354.

FRITSCH, M.; KAUFFELD-MONZ, M. (2010): The Impact of Network Structure 
on Knowledge Transfer: an Application of Social Network Analysis in the 
Context of Regional Innovation Networks. In: Annals of Regional Science. 
44, S. 21–38.

FÜRST, D. (2001): Über die informelle Infrastruktur des Handlungssystems bei der 
Selbstorganisation von Regionen. In: Geographische Zeitschrift. 89, S. 32–51.
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GLÜCKLER, J.; DEHNING, W.; JANNECK, M.; ARMBRÜSTER, T. (2012) (Hg.): 
Unternehmensnetzwerke. Architekturen, Strukturen und Strategien.  
Heidelberg: Springer Gabler. 

GLÜCKLER, J.; RIES, M. (2012): Why being there is not enough: Organized 
Proximity in Place-based Philantropy. In: Service Industries Journal. 31, 
S. 515–529. 

GLÜCKLER, J.; HAMMER, I. (2012): Situative Organisatorische Netzwerkana-
lyse. In: Zeitschrift Führung und Organisation. 80, S. 379–386. 

GLÜCKLER, J. (2011): Islands of Expertise: Global Knowledge Transfer in a 
Technology Service Firm. In: BATHELT, H.; FELDMANN, M.; KOGLER, D-F. 
(Hg.): Beyond Territory: Dynamic Geographies of Innovation and Knowledge 
Creation. London: Routledge. S. 207–226.

GLÜCKLER, J. (2010): The Evolution of a Strategic Alliance Network: Exploring the 
Case of a Stock Photography. In: BOSCHMA, R.; MARTIN, R. (Hg.): Handbook 
of Evolutionary Economic Geography. Cheltenham: Edward Elgar. S. 298–315. 

GLÜCKLER, J. (2010): The Creation and Diffusion of Controversial Innovations 
at the Organizational Periphery. In: SPACES online. 8, S. 1–22. (abrufbar 
unter URL: http://www.spaces-online.uni-hd.de/include/SPACES%202010-
06%20Glueckler.pdf, Stand 22.10.2012). 

GLÜCKLER, J.; GOEKE, P. (2009): Geographie sei was Geographen tun: Ein 
Blick hinter den Organisationsplan einer Disziplin. In: Berichte zur deut-
schen Landeskunde. 83, S. 261–280. 

GLÜCKLER, J. (2008): Die Chancen der Standortspaltung: Wissensnetze im 
globalen Unternehmen. In: Geographische Zeitschrift. 96, S. 125–139.

GLÜCKLER, J. (2007): Economic Geography and the Evolution of Networks. 
In: Journal of Economic Geography. 7, S. 619–634.

GRABHER, G. (2006): Trading Routes, Bypasses and Risky Intersections: Map-
ping the Travels of Networks between Economic Sociology and Economic 
Geography. In: Progress in Human Geography. 30, S. 163–189.

GRABHER, G. (1997): Organizing Diversity: Evolutionary Theory, Network 
Analysis, and Post-Socialism. Regional Studies. 31, S. 533–544. 
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GRAF, H.; HENNING, T. (2009): Public Research in Regional Networks of 
Innovators: A Comporative Study of Four East German Regions. In: Regional 
Studies. 43, S. 1349–1368. 

HENNEMANN, S. (im Erscheinen): Evaluating the Performance of Geogra-
phical Locations in Scientific Networks with an Aggregation – Randomi-
zation – Resampling Aproach (ARR). In Journal of the American Society 
for Information Science and Technology. (zur Publikation angenommen).

HENNEMANN, S. (2012): An Alternative Approach to the Calculation and 
Analysis of Connectivity in the World City Network. GaWC Research Bul-
letin 401. (abrufbar unter URL: http://www.lboro.ac.uk/gawc/rb/rb401.
html, Stand 22.10.2012). 

HENNEMANN, S.; RYBSKI, D.; LIEFNER, I. (2012): The Myth of Global Science 
Collaboration – Collaboration Patterns in Epistemic Communities. In: Jour-
nal of Infometrics. 6, S. 217–225. 

HENNEMANN, S.; WANG, T.; LIEFNER, I. (2011): Measuring Regional Science 
Networks in China: A Comparison of International and Domestic Biblio-
graphic Data Sources. In: Scienometrics. 88, S. 535–554.

HENNEMANN, S. (2010): Hierarchien im Chinesischen Wissenschafts- und 
Technologiesystem – Systemreformen und ihre Auswirkungen auf Wissens-
flüsse. In Geographische Zeitschrift. 98, S. 155–174.

HENNEMANN, S.; LIEFNER, I.; WANG, H. (2010): Netzwerke in der Grund-
lagenforschung in den Optischen Technologien Chinas. In: Berichte zur 
Deutschen Landeskunde. 84, S. 137–152. 

KRÄTKE, S. (2012): How Manufacturing Industries Connect Cities across the 
World: Extending Research on „Multiple Globalizations“. GaWC Research 
Bulletin 391. (abrufbar unter URL: http://www.lboro.ac.uk/gawc/rb/rb391.
html, Stand 22.10.2012). 

KRÄTKE, S. (2010): Regional Knowledge Networks: a Network Analysis Appro-
ach to the Interlinking of Knowledge Resources. In: European Urban and 
Regional Studies. 17, S. 83–87.

KRÄTKE, S.; BRANDT, A. (2009): Knowledge Networks as a Regional Develop-
ment Resource: A Network Analysis of the Interlinks between Scientific 
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Institutions and Regional Firms in the Metropolitan Region of Hannover, 
Germany. In: European Planning Studies. 17, S. 43–63. 

LIEFNER, I.; HENNEMANN, S. (2011): Structural Holes and new Dimensions 
of Distance: The Spatial Configuration of the Scientific Knowledge Network 
of Chinaʼs Optical Technology Sector. In: Environment and Planning A. 
43, S. 810–829.

STEINBRINK, M.; ZIGMANN, F.; EHEBRECHT, D.; SCHEHKA, P.; SCHMIDT, 
J.-B.; STOCKMANN, A.; WESTHOLT, F. (2010): Netzwerk(analys)e in der 
deutschen Humangeographie. In: Berichte zur deutschen Landeskunde. 4, 
S. 309-358.

Ein Blick auf die in dieser Liste aufgeführten Studien verrät, dass sich die Anwen-
dungen der SNA in der deutschsprachigen Geographie bisher vornehmlich auf 
wirtschaftsgeographische Fragestellungen konzentrieren. Bis auf fünf Titel, die 
sich der (geographischen) Wissenschaftsbeobachtung zurechnen lassen (Glückler, 
Goeke 2009; Grabher 2006; Hennemann et al. 2012; Hennemann et al. 2011; Stein-
brink et al. 2012), sind alle Beispieltexte wirtschaftsgeographischer Provenienz. 
Insbesondere in den Themenfeldern Standortforschung und Innovationsforschung 
sowie bei der Erforschung von Produktionsnetzwerken, Wertschöpfungsketten 
oder Wissensclustern konnten die Methoden der formalen Netzwerkanalyse bereits 
sehr erfolgreich angewendet werden.

Die Zusammenschau deutet stark darauf hin, dass die deutschsprachige Sozial- 
und Kulturgeographie die SNA noch kaum für sich entdeckt hat. Das erstaunt 
durchaus, denn erstens steht die SNA doch eher in der sozialwissenschaftlichen als 
in der wirtschaftswissenschaftlichen Forschungstradition und zweitens mangelt es 
jenseits der Geographie keineswegs an sozialwissenschaftlichen (auch raumbezo-
genen) Anwendungen der SNA.52 Da es an potentiellen Anwendungsfeldern nicht 
fehlt, scheint die Sozial- und die Kulturgeographie deutlichen Nachholbedarf in 
Sachen SNA zu haben. Das Potential der SNA ist bei weitem nicht ausgeschöpft. 
Es tun sich somit sehr schöne Forschungsperspektiven auf …

Wenn es gelungen sein sollte, den methodischen Einstieg in die SNA zu erleichtern, 
hat das Buch seine Funktion erfüllt; wenn daraus sogar Forschung erwachsen 
sollte, wären wir froh!

52 Für die Sozialgeographie inspirierend mag die von Markus Gamper und Linda Reschke herausgegebene Reihe 
Knoten und Kanten sein, die inhaltlich ein breites Anwendungsspektrum abdeckt und bisher zwei Bände umfasst 
(2010; 2012): Gamper, M.; Reschke, L. (Hg.): Knoten und Kanten – Soziale Netzwerkanalyse in Wirtschafts- und 
Migrationsforschung. Bielefeld: transcript; Dies. (2012): Knoten und Kanten 2.0 – Soziale Netzwerkanalyse in 
Medienforschung und Kulturanthropologie. Bielefeld: transcript.
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In den Sozialwissenschaften profiliert sich derzeit eine disziplinübergrei-
fende Netzwerkforschung, die sich durch eine relationale Theoriepers-
pektive auszeichnet. Die empirische Forschung greift dabei vermehrt auf 
das Methodenrepertoire der Social Network Analysis (SNA) zurück. 

Für die Humangeographie kann der soziologische Blick der Netzwerk-
forschung auf unterschiedliche Weise um „Raumbezüge“ ergänzt und 
in verschiedenen Forschungsfeldern zur Anwendung gebracht werden. 
Trotz ihres vielfältigen Potenzials nimmt die SNA in der geographischen 
Methodenausbildung in Deutschland bisher einen eher untergeordneten 
Stellenwert ein. 

Dieses Buch richtet sich an Studentinnen und Studenten, die sich für 
(humangeographische) empirische Netzwerkforschung interessieren 
und einen einfachen Einstieg suchen. Es führt verständlich in zentrale 
Fachbegriffe der SNA und die grundlegenden Funktionen der Analyse-
Software UCINET ein. Von der Dateneingabe und -aufbereitung, über die 
Visualisierung bis hin zu netzwerkanalytischen Berechnungen werden 
die ersten Schritte vorgestellt und nachvollziehbar erläutert.
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